
 



Vision: A Resource for Writers 
Issue # 20 

2
 

Table of Contents 
Issue # 20,  

March/April 2004 

Cover  

About this issue 

Editor's Note: 

Stories to Tell 

Workshop:  

Create a Writing Collage 
By Leah Tribolo 

Interview:  

Time Space and Mark Tiedemann 

By Russell Gifford 

Theme Articles: 

Footsteps to a Novel 

By Margaret McGaffey Fisk 

How I Planned my First Novel 

By Joanna Cravit 

Writing Novels 

By Jon Chaisson 

Lazette Gifford, Editor 
vision@lazette.net 

2 of 147 



Vision: A Resource for Writers 
Issue # 20 

3
 

NaNo Reflections 

By Peggy Kurilla 

Conquering Writer's Block 

By J M Edwards III 

Keys to Great Endings 

By Crista Rucker 

The Freedom to Write 

By Lazette Gifford 

Advanced Writing Articles: 

A Little Bit of Science 

By Kate Paulk 

Brothers and Others: Creating Aliens that Aren't Alienating 

By Kat Feete 

Microsoft Help Files: 

Using Microsoft Word to Cut Though the Hesitation Shuffle  

By Russ Gifford 

Reviews: 

Book Review:  

Painless Grammar 

Reviewed by Andi Ward 

Lazette Gifford, Editor 
vision@lazette.net 

3 of 147 



Vision: A Resource for Writers 
Issue # 20 

4
 

Website Review: 

The World Heritage Website 

Reviewed by Maria Gianakos 

Market Report: 

Mar's Market Report # 2 

By Margaret McGaffey Fisk 

Good News from Forward Motion 

Submission and Guidelines 

Join Forward Motion 

Masthead 

Email 

Back Issues 

Entire contents Copyright 2004, Forward Motion E-press. 

 

Lazette Gifford, Editor 
vision@lazette.net 

4 of 147 

mailto:vision@lazette.net?subject=Issue%2020
http://fmwriters.com/Visionback/Index.htm


Vision: A Resource for Writers 
Issue # 20 

5
 

About This Issue 

 

 

March/April 2004 

Issue # 20 

Theme: Writing Novels 

Welcome to Issue # 20! 
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Spring is just around the corner for those of us in the northern 

hemisphere.  For many, the coming of spring brings a renewed 

interest in many things, including writing.  If you are considering 

working on a novel, here is help, inspiration, and understanding of the 

difficulties. 

And once again, I would like to invite any of you to submit nonfiction 

writing-related articles to Vision.   Tell us about your writing 

experiences, and remember that many people have had their first 

publications with Vision.  If you have something that you think might 

help another writer, then give writing a short article a try.  

Upcoming Themes for Vision in 2004:   

••  

••  

••  

••  

May/June -- Writing Shorter Fiction  (April 10 deadline)   

July/August -- The Fine Points of Critiquing (June 10 deadline)   

September/October -- Essentials of Marketing  (August 10 

deadline)   

November/December -- Toys for Writers (October 10 deadline)  
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Upcoming Events at Forward Motion: 

••  

••  

••  

••  

••  

••  

Back to School for Busy Writers features a class on Giftedness 

and another on Television's Cultural Icons. 

March Challenge -- Write, Edit and Submit a story written for 

someone 13 years or Younger 

Out Like A Lion March Madness -- One week to write from 

10,000 to 40,000 or more words! 

April Challenge -- The return of the popular Haiku Challenge! 

The Dvorak Challenge -- Are you considering changing from 

Qwerty to Dvorak? 

On April 1 we will start the second two month dare of the year.  

The dares cover new material and rewrites, novels, short 

stories, poetry, articles, and much more!  Join in the fun! 

Come and join us in the fun and insanity! http://fmwriters.com  

I hope you enjoy the issue!  

Lazette Gifford, Editor 
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Editor's Note: Stories to Tell 

By Lazette Gifford 
©2004, Lazette Gifford 

 

As you can tell, I've changed some of the set up for Vision again.  

One of the joys of working with an ezine is that it is so easy to change 

and experiment with as far as the layout is concerned.  

However, as much as I love working with Vision, by the time I get 

each issue finished and up on the site, I'm more than ready to go 

back to work on regular writing.  Appropriately for this issue, I have 

three novels calling to me right now, and it's been difficult not to 

'forget' that I have work to do elsewhere and just throw myself into 

one of them.  They are in three different stages; the first in final 

rewrite/edit, the second in first draft, and the third in note/outline 

phase.  I want to move forward on all of them.  Instead, I've worked 

on Vision and Forward Motion material for the last couple days. 

They call to me.  They haunt my thoughts at night when I'm trying to 

sleep.  Pieces of dialogue and bits of intrigue hit in the middle of 
Lazette Gifford, Editor 
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dinner and I have to reach for my PDA and jot things down.  I'm lucky 

that my husband understands. 

The one thing I could wish for everyone who reads Vision is that they 

find the same joy in writing that I've always had. 

I hope that you find helpful material in this issue.  Good luck with your 

writing.  And now that this is posted and the new month has begun, 

you'll find me back at the work I love the most.  I have stories to tell. 

Have fun,  

Zette 

Lazette Gifford, Editor 
vision@lazette.net 
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Workshop: Create a Writing Collage  
By Leah Tribolo 

©2004, Leah Tribolo 

(Originally published in Writer's Digest) 

 

Freeing Your Novel Ideas Creatively  

Try using visual form to free your novel ideas.  Then, watch as the 

images guide and inspire your words. 

What is a Writer? 

Writers are artists.  Our medium of expression is words.  Like any art 

form, writing is about communication.  

Since humans do not exist in isolation, the ideas we have are not 

unique.  Indeed, in this Information Age, we are bombarded with 

others' ideas.  The originality of our art is in how we choose to 

express our creativity.    This makes collage an ideal writing tool.  

Collage gives the author a visual encyclopaedia to reference while 

writing.  Start the process of putting your novel ideas onto paper with 

collage. 
Lazette Gifford, Editor 
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It will help you: 

• Visualise characters through character profiles.  

• Structure major events in a novel.  

• Clarify central themes, mood and issues.  

  

What is Collage? 

Collage is a technically simple, visual art form.  It uses different forms 

of media, such as magazine clippings, to generate an image. There 

are no rules with collage -- not even the writing commandment to be 

internally consistent.   

Since we are using collage to keep track of our own ideas, it is not 

necessary that our collage have ascetic appeal.  Our collages must 

only reflect what we would like to remember and express when 

writing. 

The following are essential materials for collage making: 

• Scissors  

Lazette Gifford, Editor 
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• Posterboard  

• Gluestick  

• A pile of old magazines, and other material you have that 

relates to your novel characters, themes, and/or issues.  (Use 

your imagination: felt pen, paint, shells, photos, etc.  Whatever 

inspires you!)  

With your pile of magazines at hand, begin by cutting out material 

relevant to your characters, themes and events to occur in your 

novel.  (I also cut out material that interests me and then use it as a 

brainstorming aid.)   

After you have sufficient visual information or have exhausted your 

supply of creative material, divide it and organise into categories, 

such as: 

• Character imagery  

• Major events  

• Overall moods and themes  

Lazette Gifford, Editor 
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To organise your categories, keep them in file folders or pinned on a 

bulletin board until you are ready to create the collages. 

Character Profiles 

To begin your character profiles, paste picture(s) of the desired 

character onto the posterboard and any imagery you have that 

provides characterisation, such as a hat, ring or specific posture.  

Where does he come from?  Can you find a picture that shows his 

history?  The care you take in creating your character will be reflected 

in your writing.  

As your novel progresses, your profiles should change.  Paste a new 

picture over the old, or keep the old in the centre of the picture and 

paste around in an outward spiral as your character grows. 

In conjunction with character profiles, it is effective to create a 

sociogram.  This is a diagram showing how people are 

interconnected.  A collage dedicated to this is essential.  Take a 

picture of each of the main characters and assemble them on 

posterboard linking them with felt and a few words about how they 

Lazette Gifford, Editor 
vision@lazette.net 
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and other recurring characters are interconnected.  This will be a 

valuable reference when trying to remember who is who and why. 

Structure 

Structuring the major events to occur is part of the novel planning 

process.  Using a timeline with collage is a powerful tool.  A timeline 

allows us to sequentially order our thoughts, while the visual aspects 

of collage allow us to accomplish with the verbal minimum what will 

occur at the turning points in our novels.  

Make a timeline on some posterboard and paste pictures that help 

you remember what is to occur at major turning points.  The pictures 

will aid you in remembering essential details.  They also provide a 

visual prompt for the mood occurring in your novel at different times. 

Clarification 

Collage is useful in clarifying central themes, issues and mood.  

Begin, again, with a posterboard and work from there with imagery 

that speaks to you of your ideas.  If you decide you do not like 

Lazette Gifford, Editor 
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something, it is simplicity itself to remove the offending image or glue 

over it with another.   

As you gather information for your novel, you might notice recurring 

colours or imagery, which suggest the mood for you to set in your 

novel.  Perhaps you keep cutting out pictures that will make powerful 

metaphors within your novel setting.  Or perhaps you run across 

topics that you feel are "bigger picture" issues that could serve well 

as backdrops for your story.  (War, genetic engineering or colonial 

America are all good examples.) 

And more... 

Collage can seem time-consuming until you are used to collecting the 

images and materials.  But once you are, collage will also help you:  

• Retain ideas you are currently unable to pursue.  

• Decide on a cover format (Perhaps you have a picture that 

reflects a character or theme of your novel.)  

• Brainstorm future novel ideas.  

Lazette Gifford, Editor 
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With practice, collage can become an essential tool in your writing 

arsenal, saving you time by providing information and inspiration in a 

condensed visual form. 

Lazette Gifford, Editor 
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Interview: Time, Space  

and Mark Tiedemann 

By Russell Gifford 
©2004, Russell Gifford 

 

When Jeffrey Carver, Jack McDevitt, Allen Steele 

and David Brin write blurbs for your first novels, you 

know the work inside must be good. Equally 

important, you know it must be good SF. Mark 

Tiedemann is a journeyman writer, with a solid 

history of short story sales before he embarked on 

the Isaac Asimov's Robot City novels. Mirage, Chimera, and Aurora 

were published by iBooks in 2000, 2001, and 2002, and are currently 

being republished in mass market paperback now.  

Also in 2001, he published the acclaimed trade paperback novel 

Compass Reach for Meisha Merlin Publishing. The story earned him 

a nomination for the Philip K. Dick Award for 2001, and has 

generated two more novels in the Secantis universe, Metal of Night, 

Lazette Gifford, Editor 
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and Peace & Memory. (Unabashed plug - read this interview, then go 

to www.meishamerlin.com and order all three. You'll get a great deal, 

and a great read!)   

For up to date information about his publications and appearances, 

visit Mark Tiedemann's web site at http://www.marktiedemann.com. 

Vision caught up with Mark Tiedemann at home, shortly after his 

Guest of Honor appearance at the Chattanooga SF convention in 

January.   

Vision: Where did you get your start in writing? What was your first 

sale, and when? Was it a dedicated effort, made after many tries, or 

something sent in on a whim and simply the first of your many sales?  

Mark: Emulating comics as a kid.  I used to draw all the time 

and as I grew older I began putting stories to my illustrations.  I 

think I really wanted to make movies, but this was as close as I 

could get.  My first sale came in 1982, I believe, to Space & 

Time magazine.  I spent far more than the fee buying the 

original illustrations!   

Lazette Gifford, Editor 
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Oh, I became serious about getting published a year or so 

before, when my companion, Donna, suggested I could sell my 

stories.  I turned it into a daily ritual and did the rounds of all the 

major magazines.  We had begun making jokes about 

wallpapering the apartment with rejection slips when Gordon 

Linzner accepted a story.  That sale just whetted my appetite. 

Vision: You've sold to most of the short story SF magazines of the 

last 20 years, including Asimov's, SF&F, and Science Fiction Age. 

What is your preferred genre? (Assuming it is SF) The page in 

Compass Reach reads like a who's who in today's SF/Fantasy genre! 

Who do you credit as your major influences?   

Mark: I prefer science fiction.  Most kinds.  I'm old enough to be 

part of the generation that lived and died by the periodicals.  

They were beginning to decline when I discovered them, but I 

remember getting Galaxy, The Worlds of IF, Venture SF, 

Vertex, as well as Analog, F & SF, and Amazing.  Admittedly, 

when I started reading novels, the short fiction kind of faded for 

Lazette Gifford, Editor 
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me.  By high school I'd pretty much stopped reading the 

magazines.  

But I caught the reading flu around nine or ten and my mother 

still had a trunk full of her Doubleday Book Club 

books.  So I cut my teeth on a lot of mainstream 

writers few people talk about today.  Costain, 

Yerby, Marshall, Slaughter.  So for me, there 

was an overlap of genre from an early age.  I 

was very much an omnivorous reader then.  When I started 

really getting into SF, I found myself looking for the same level 

of -- I wouldn't call it craft; maybe immersion is the word, which 

is a consequence of good writing.  So early on I embraced 

people like Zelazny, Pangborn, Asimov, Moore.  

The book that made me want to actually write science fiction 

was Asimov's Foundation series.  I thought "This is the real 

thing!  This is what I want to find in a story!"  It took a long time 

before that came to fruition.  

Lazette Gifford, Editor 
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Lately, I've been getting back to an omnivorous diet of reading.  

As long as the writing is good, I don't care what the genre is so 

much. 

Vision: What do you think makes good science fiction today? Or: DO 

you feel science fiction today IS good? 

Mark: In some ways, SF today is better than it has ever been.  

The stories feel better-realized, the scope of imagination is 

richer, and the characterization is by far the best it has ever 

been.  The bar has steadily raised since Campbell took over 

Astounding back in 1938 and has culminated in works of 

luxurious depth and marvelous detail.  It has always been true 

that the best material is about what people will go through in the 

face of the various unknowns SF explores, but the range has 

been extended.  The ways in which the challenges of new 

science, new discovery, and new history work through people 

have multiplied to include every possible human attribute.    

The primary strength SF claims for its aesthetic is the evocation 

of Sense of Wonder.  That's still true, but more and more it's 

Lazette Gifford, Editor 
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combined now with the evocation of all the other human 

emotions -- those things other genres have based their 

aesthetic potentials on and which SF through a good portion of 

its history underplayed.   When you run across a novel like 

Kelley Eskridge's Solitaire or Jamil Nasir's Distance Haze or 

Carter Scholz's Radiance you can't help but think we're in a 

terrific period of really great writing.  

So, yeah, I think SF is good today.  It is very good today.  

On the other hand, I see a lot of SF that has embraced the 

jargon of the genre so much that it leaves inexperienced 

readers behind.  Or outside.  The stories are often being written 

for the benefit of other SF writers and the dedicated fan at the 

expense of leaving a little room for a new reader to find a way 

through the text.  The writing is still technically good, but it's 

specialized way too much.  

Lazette Gifford, Editor 
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What has always made SF good, though, hasn't changed: it 

is potential to ask complex questions and tackle philosophical 

issues in ways that are beyond mere theory.  

Science fiction has always had the ability to act 

as a test bed for new ideas.  We build our models 

-- testing a new way to see mind-body dualism or 

the problem of Other Minds or the moral 

problems of genuine biological improvement or the economic 

questions that arise out of a post-scarcity civilization -- wind up 

the Cartesian clockworks, so to speak, and see how these 

 out through "real" people, namely the characters. ideas play

Vision: Tell us about the Asimov Robot books - that 

creation/extension of these works? 

seems like quite a project. How did it come about? 

Assuming you are "of a certain age," you remember a 

time when Asimov nearly defined science fiction to 

most of the country.   How does it feel to be in the 

driver's seat for the expansion of such a key part of SF history? Can 

you share any moments of excitement (or panic!) on the 

Lazette Gifford, Editor 
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Mark: Quite literally, I was in the right place at the right time.  

The Robot Mysteries are based on the Robot City universe 

created by Asimov in the '80s.  This was the last contract open 

in that milieu and Byron Preiss was looking for someone to 

write the material.  I had to "audition" for the job, which led later 

to the publication of my own novel, Realtime.    

e idea of using 

the Three Laws in what became essentially "locked room" 

mysteries seemed a natural fit.   

zed that I had a 

chance to comment on one of the central 

mysteries of the whole Asimovian construct.  

What became of the Spacers and, more 

 The problem I saw with the Three Laws is 

a set forth on what is meant by Human.  

Asimov had no aliens in his universes so that small problem 

It was less intimidating than I expected.  I grew up reading 

Asimov, the universe was familiar to me, and th

The best part of it came during the writing of the 

last volume, Aurora, when I reali

importantly, Why? 

that there is no criteri

Lazette Gifford, Editor 
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was sidestepped.  But with the advent of genetic alteration and 

advanced cybernetic prosthetics, what definition of Human are 

all these robots using?  Clearly, Asimov used a biological 

definition.  But the Spacers had changed themselves and, in 

the case of the Solarians, were continuing to change -- so on 

what basis do the Three Laws maintain?  I gave an answer, 

which I won't spoil here, that I think is a direct response to the 

dilemma Asimov set up.  I have to say, that was exhilarating.  

Vision: Your scenes are VERY clearly painted, almost like a picture. 

Readers can see the trash on the floor and the graffiti on the walls, 

Mark: Probably.  But I've always read with a motion picture 

screen running in my imagination.  When I was a kid I'd play 

yet it never overwhelms. The action and the situation flow from the 

picture into the moment for you. Is that a result of your years of 

photography? 

games with new books, casting actors in the various parts as if I 

were watching a film.  I've always been strongly visual in my 

approach to, well, everything.  As I said, I drew comics as a 

Lazette Gifford, Editor 
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child.  Photography came naturally to me.  Getting the action 

right, getting the scene right, I think, is vital to the writer's craft.  

Stories from which the visual elements are difficult to imagine 

fail for me. 

Vision: Speaking about photography....(smile) which do you prefer - 

digital or film? Darkroom or computer? How deep into photography 

Mark: I started doing my own darkroom work 

when I was fifteen.  Maybe that suggests my 

f

I am a very serious photographer.  I've made my living at it for 

thirty years, in the lab, the studio, and for a short while in retail.  

are you, and how do you feel it affects your writing?    

this is how the 

preference.  I'm of the Edward Weston/Ansel 

Adams school of printmaking.  I honestly 

haven't even looked at a Photoshop program, 

although it's becoming increasingly clear that 

uture will be.  

It has affected my writing as I indicated above by enhancing my 

visual sense.  But also, I'm very much an advocate of black & 

Lazette Gifford, Editor 
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white, which I think goes directly to writing in that it enforces an 

appreciation of composition, texture, and form which color very 

often obscures.  It makes you see what is important more 

clearly and this translates to writing very well.  

Vision: 1999 or 2000 seems to have been a breakthrough for you. 

You wrote sold short fiction for 17 years, then your chapbook comes 

  

Mark: Momentum.  When I talk to students or 

people who aspire to being a writer, the 

out from Yard Dog Press, you get the Robot City series from iBooks, 

and Meisha Merlin bought Compass Reach. What happened that it all 

seems to have come together at once? Had you been writing novels 

all along? Was there a big change that made it all come together at 

that one moment? 

question that always comes up is "What's the 

most important thing?"  They expect some 

advice about the art.  And that is important, 

Lazette Gifford, Editor 
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but it's something that is always in need of improvement, in 

need of practice, in need of honing.  You do that whether you're 

trying to publish or not.  Journal writing requires improvement.  

But what they want to know -- and often don't ask -- is what 

does it take to Get Published.  Beyond basic storytelling skills 

As for that particular year, well, the Robot Books I explained.  

The Secantis Sequence has been making the rounds for a long 

But, yes, I'd been writing novels all along.  I had them ready. 

and a professional approach to the manuscript and polish, the 

key thing is Persistence.  The people who never make are 

those who stop trying.  Some people never get the hang of how 

to write for publication.  But there are many who can write 

perfectly well but won't tolerate the rejections.    

time.  When Stephen Pagel began Meisha Merlin, he 

remembered the books from his days at another publishing 

house.  Phone calls were made.  

Lazette Gifford, Editor 
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Vision: Now - to Compass Reach and the beginning of the Secantis 

Sequence. When did you first conceive of the story, and the series? 

Mark: The series emerged from an amalgam of short story 

ideas that never quite worked.  They were better suited to 

novel-length treatment.  I had been trying to come up with a plot 

for my first novel the year I decided to apply to Clarion Writer's 

Workshop.  The one element that anchored it was my decision 

to write about people you almost never think 

about -- the poor, the disenfranchised.  A lot 

of writers have touched on the subject, but I 

didn't recall one at novel length.  So the idea 

of the interstellar hobo emerged.  I wrote the 

opening scenario, let it lie for a while until 

another idea joined it.  

Then the problem of telepathy teased at me.  I don't really buy 

telepathy, but it's a useful conceit in SF.  One of the main 

sources of a rich thematic material has always been the 

question of Other Minds.  Bit by bit the story of the first contact 

Lazette Gifford, Editor 
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between humans and aliens came together around the use of 

telepaths as interpreters -- with, of course, disastrous results.  

At some point, this merged with the hobo, and Compass 

Reach took shape.  

Once I had the background universe -- the Pan Humana, the 

Seven Reaches, the Commonwealth Republic -- other stories 

developed.  There are several short stories (including one 

about that disastrous summit between the telepaths and the 

aliens, called Texture of Other Ways) and more sketches for 

novels.  

It's a very versatile story-generating machine and I can't see 

any real limits.  

Vision: Along with the earlier chapbook at Yard Dog Press, we hear 

there's something new coming on that front. Can you illuminate just 

what a "Double Dog" is, and what your part of that will be? 

Mark: The "Double Dogs" are like the old Ace Doubles -- two 

short novels published back to back in one binding.  I've written 

Lazette Gifford, Editor 
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a space opera that takes apart the notion of the interstellar 

empire, but I've done it as a kind of homage to Jack Vance and 

Poul Anderson, two of the greatest space opera composers.  Of 

Stars and Shadows will be in one of the first couple Double 

Dogs.  

Vision: Any other hobbies or passions besides Donna, SF and 

photography that you'd like to talk about?  

Mark: Music.  I'm woefully out of practice, but I play keyboard 

and guitar, and I compose.  I've written some pieces based on 

SF stories.  The first one of these I did because the title was too 

hard to pass up -- Blues for a Red Planet, based on Allen 

Steele's short story.  It's okay, he's heard the piece and given it 

his blessing.  So I thought it would be fun to do a series of 

them.  Usually I do them for friends -- I've done one for Nicola 

Griffith, one for Kelley Eskridge, and one for Laurell Hamilton -- 

but I've done some "incidental music" for my own work.  I'm 

hoping that some time in the next couple of years I'll get the 

opportunity to record them and produce a CD.   
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Vision: Any other things you'd like to share, like the secret to selling 

lots of short fiction to lots of different magazines, or how you broke 

into the New York Times Review of SF? Perhaps the secret to 

sustaining a long term relationship - you and Donna have been 

together for over twenty years now? (Feel free to add anything you'd 

like here!) 

Mark: Donna and I have been together for (by the time this is 

published) 24 years.  She likes to read, she likes SF, and she 

really likes me.  Secrets?  Hm.  Only one observation that came 

to us in time to keep us together.  Relationships are hard to 

keep together and relationships with artists seem particularly 

so.  We realized that one reason for this is the level of 

obsessive commitment the artist has -- has to have -- to a given 

craft to be successful.  It is, in fact, a complete relationship all 

on its own.  It's much more than just a job.  It's much more like 

having a three-way partnership.  The art is, at least in its impact 

on the artist, very like another person.  
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Now, realizing this, some people might still choose to break up.  

But if you don't realize this, the stress on the relationship 

doubles because you end disregarding the true nature of the 

relationship.  

I'm sure there are couples who find a way to manage this 

without going through this particular process of discovery.  But 

the reverse seems to be more the case.  

Donna is my first reader, my first editor, the person I talk stories 

over with, the person who helps me at every stage of the 

process.  I'd go so far as to say she's more of a collaborator.  

She doesn't do any of the writing, but the writing wouldn't be as 

good as it is without her input.  

Besides -- we really like each other (which I sometimes think is 

more important that love: love is the reason, like is the glue). 

Vision: Congratulations on all your successes, and we look forward 

to many more great stories. Thank you for your time!  

Mark: Thank you. 
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Footsteps to a Novel 

By Margaret McGaffey Fisk 
©2004, Margaret McGaffey Fisk 

 

Do you have an idea for a story -- a character who won't let you rest, 

the perfect plot, or an interesting world, whether a cattle farm in 

Canada or a planet with no surface water?  All types of people have 

novel ideas, whether they are writers or not.  Most ideas never 

become completed works, and the reason may be found in the word 

"work."  Writing seems easy as you dash off a letter to Aunt Sally or 

complete your latest essay on the lifestyle of brown and black 

gerbils.  However, writing for publication, especially writing a novel, 

requires a commitment few are willing to make. 

If you think you are ready to put in the effort, time, and focus, having 

some guidelines can greatly improve your chances of converting your 

idea into a finished piece of literature.  There are many ways to 

approach a novel and any of them that end in a finished work are 
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valid.  The method I present below is one I've found effective and 

have used  to complete three novels so far. 

First, a word about progress and the time it takes to write a novel.  I'm 

a strong advocate of completing a draft before editing.  Though this 

does not mean accepting each sentence as it pours from your 

fingers, it does mean no re-reading of the earlier words with the intent 

to modify them.  Discuss the idea with friends and family as much as 

you like, but hold your completed chapters close to the chest.  

Nothing stops progress as easily as the "well, it would make more 

sense if..." from someone reading your uncompleted novel.  Almost 

anything can be fixed in the edit cycle, but if editing on chapters 1-10 

starts before 11-32 are begun, the odds of the later chapters ever 

being written are severely reduced. 

Writing a novel is all about dedication and perseverance.  As much as 

possible, avoid anything that threatens your objectives.  You should 

never invite a hazard into your path.  Honestly, writing a novel is 

complex enough without asking for trouble. 
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My process involves five steps.  These may seem simple on the 

surface but they encompass significant effort. 

I'm going to borrow from Snow White and the Seven Dwarves to take 

you through the process because the familiar story line will help 

everyone focus on the steps, rather than whether or not to borrow 

elements of the idea. 

Step 1 - Idea 

This is the easy step since most people already have at least one 

idea. 

Evil stepmother jealous of princess 

Step 2 - Start Looking at the Story Behind the Idea (Very Basic 

Plotting) 

We have an idea above, but it's not a story yet.  To have a story, 

there must be a beginning, middle and end. 

The beginning should introduce the main characters, Snow White 

(protagonist) and the wicked queen (antagonist).  The middle should 
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be filled with the queen's efforts to kill Snow White and the end -- this 

is a fairy tale -- should be happily ever after.  Oops, that means we're 

missing at least one more character.  There has to be a prince.  

Better tuck him into the beginning somewhere. 

Step 3 - Creating Your Outline 

A plot, no matter how simple, involves a lot of moving pieces: 

characters, scenery, motivations, foreshadowing, and many other 

elements.  An outline is a simple device to keep things straight.  It is 

your general guideline as you move forward to ensure you don't 

become bogged down trying to figure out what should happen next. 

There are many people who believe an outline will kill their writing by 

stifling their creativity and destroying their interest in the story.  That 

may be true depending on the type of outline created and the 

person.  If you have never used an outline, I would suggest trying my 

approach before rejecting them altogether.  I am an organic writer.  

As I go along, my characters reveal secrets and go off in different 

directions and even flesh out pieces I thought I could skim over by 
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pointing out something critical that happened in that moment.  This 

does not in any way prevent me from using outlines. 

Since I began outlining, my time to completion of a novel has dropped 

from seven years to two-to-four months and even down to one month 

for a 116,000-word novel during the National Novel Writing Month.  

My speed has more to do with how many words I'm willing to commit 

to on a daily basis.  However, continual progress on each day is due 

to my outline.  I can focus on crafting words rather than figuring out 

what's going to happen next and how something fits within the 

existing plot.  This allows me to make steadier progress because I've 

done most of my thinking in advance.  My last purely organic book, 

Destiny's Path, ended up being a difficult edit because I had an end 

in mind but forgot to drive toward it in the text.  The events built up to 

the final success but not in a way clear to the reader.  If I'd used an 

outline, the notes should have been enough to remind me as I built 

each scene. 

My outlines focus on scenes split by point of view (POV).  This allows 

me to track how often a given character owns a scene and to make 
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sure I'm not straying away from characters for so long that the reader 

forgets them.   

My Excel template is available for download here: 

http://margaretfisk.home.comcast.net/writing/writing_tools.html . 

Whatever form of outline you use, whether notecards, word processor 

or spreadsheet, just start out simply.  I'd recommend not using just a 

single sheet of paper because your outline can, and should, change 

as you go along.  The basic outline only requires three parts. 

Beginning: 

Write a sentence or two showing the beginning of your story.  This 

could describe the first chapter or first three; just get something 

down.  However you track POV, use it to categorize this piece.  If you 

are not planning to track POV or even if you believe your novel will 

end up in a single POV, I would recommend noting the viewpoint 

anyway.  It does not take a lot of effort and can make you more 

flexible later on. 
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Snow White dreams about her prince but when he stops by, she's 

scared and runs away. 

Middle: 

Write a sentence or two indicating the middle part.  What's going to 

happen over the course of the story to build toward the conclusion?  

Again, a general sentence describing most of the novel is fine. 

Jealous stepmother tries to kill princess but she escapes, though the 

last attempt leaves her in a coma. 

End: 

Write a sentence or two showing where you want to end up.  This will 

serve to keep you in line because everything coming before should 

drive to this end.  However, if as you build out the story, it makes 

more sense for Snow White to marry Dopey, you can always modify 

the end.  It's important to build toward something as you write.  

Without a known endpoint, it's too easy for a story to become "and 

then, and then, and then."  This is a common cause for writers to lose 
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interest because the story has no focus and no sense of approaching 

a resolution. 

Prince finds princess and frees her with a kiss.  They live happily ever 

after. 

You've finished your outline and you can jump into the book, right?  

Well, it depends.  If you feel any more of an outline will constrain your 

creativity, even this much can assist in keeping the plot in order.  

However, the more you build your plot, the less you have to figure out 

as you write and the easier you can tell when a new plot thread will 

blend in nicely or require an entirely different outline. 

I usually don't start writing until I have about half the scenes in my 

outline listed as a short sentence or two each.  This gives me enough 

to get started while allowing character and plot growth along the way.  

Often, extra scenes or threads come to me as I approach the place 

where they would fit.  Sometimes, I have to stop work altogether to 

rebuild a portion of the outline reflecting the changes.  This process 

helps me think the change through. 
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Now is the time to figure out if you have any elements requiring 

research.  For example, can you really put a person in death-like 

sleep and for how long before that glass enclosure holds a rotting 

corpse?  Oops, you tell me you are writing a fantasy?  Switch your 

research to clothing in medieval times.  The likelihood of needing to 

research at least one element is high.  Do you know enough about 

diamond mining to make the readers nod their heads when the 

dwarves go off to work, or will they throw the book away in disgust?  

Here is where you identify what you might want to research, although 

you don't necessarily have to do the work in advance; some people 

do, some people don't. 

Step 4 - The Actual Writing 

A novel is anything from 80,000-125,000 words long depending on 

the genre and market.  (Young adult literature is lower and some 

specialty markets have different high ranges, but this spread covers a 

large portion of the novel markets.)  Estimating a word count of 

100,000, just how long should this novel take to write?  Well, the real 

answer, as ambiguous as it may seem, is as long it needs to.  
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However, since reaching your precious -The End- marker is a terrific 

thrill, let's look at some goals to set you on your way. 

  

Word Count Goal Days of the Week Total Days 

1000 Monday-Sunday 100 

1000 Monday-Friday 140 

1000 Saturday-Sunday 350 

500 Monday-Sunday 200 

500 Monday-Friday 280 

500 Saturday-Sunday 700 

250 Monday-Sunday 400 

  

As you can see from the chart, the more words per day and the more 

days you can commit, the sooner the novel will be completed.  Okay, 

it may seem too obvious to mention, but people don't really think 

about writing that way.  If you commit to 1000 words per day, you can 

complete 3 and 2/3rds novels each year.  This is excluding editing, 
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world building and other elements necessary to bring a novel to 

market, but it is still an incredible factoid. 

While 1000 words a day may seem unachievable, if you have at least 

two hours free, you could be amazed at how much consistent 

progress you can achieve.  A good outline, so you don't have to plot 

and write simultaneously, helps keep the words coming.  A warning 

though: setting high goals from the start is likely to frustrate and stall 

you.  To consistently achieve a daily word count goal is something to 

build toward until it becomes a standard part of your routine, whether 

you set a specific time or make completing your words a requirement 

before relaxing. 

As you write, remember the outline is flexible.  Sometimes, the 

original concept is either limited or flawed in ways not immediately 

apparent.  While I recommend working from some sort of outline, 

don't let it trap you.  If your characters reveal a new twist or direction, 

take a pause in writing and work out how to integrate the change into 

your outline.  This serves a dual purpose.  You let your subconscious 

improve on the original idea and, by conceptualizing through your 
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outline, you can identify pointless deviations from your plot before you 

are mired in a series of events with no purpose. 

Step 5 - The End 

Whatever your goal, if you remain determined, the day will come 

when you write or type -The End- at the bottom of your manuscript.  

Take a deep breath.  You have now achieved what most would-be 

novelists never do.  At this point, I recommend taking some time 

away from the story before beginning your edit.  It's a grand 

opportunity to start on your next idea. 
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How I Planned My First Novel 

by Joanna Cravit 
©2004, Joanna Cravit 

 

Last year I wrote my first novel. I knew that it would not be 

publishable; although I have written dozens of short stories, and lots 

of nonfiction for my day job, this was my first attempt at a novel-

length story, and I resolved to treat it as a practice run. My goal was 

simply to finish it and to see if I really could sustain a narrative of that 

length and complexity. 

For a first attempt, the novel did have its good points. I had a solid 

handle on my characters and their motivations and backstory. And 

my dialogue was good.  However, as my writing group buddy 

explained to me, 200 pages of people having conversations -- even 

very nicely written ones -- is not a plot. Stories need to actually have 

parts in them that aren't conversations! Clearly, I would have to go 

back and do structural work if the novel was to be any good. 
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Our writing group decided to see if we could do any better the second 

time around.  One member, who had taken a writing class earlier that 

year, agreed to help us work through some story planning exercises. 

Below is the entire planning process we went through, using 

examples from my practice novel to show what we did.  

Step 1: Begin with an Idea 

For our first meeting, we began by briefly talking about the best way 

to ensure a tight plot: to have characters with clear goals and 

motivations. This allows the story to be paced via setbacks that keep 

the character’s goal out of reach. Well-planned turning points allow 

the story to advance to its climax. 

With this basis established, each person offered a one or two 

sentence summary of their basic story idea, and invited everyone 

else to make suggestions on it. It was interesting to see how different 

people interpreted the same basic idea.  

My premise involved four friends who reunite years after an accident. 

I was interested in exploring how these people had changed in the 
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intervening years. One had hooked up with the other's ex, and 

another had escaped the accident unscathed only to undergo 

traumas of her own later.  

One of my writing buddies was interested in having the two former 

flames hook up again (thus complicating their current relationships) 

and another wanted a revenge story where instead of hooking up with 

her ex, she punishes him for leaving her! 

Step 2: Work on the High Points 

Our homework was to try and work on a general outline of the high 

points of the story, which were explained as follows:  

Story begins with an unstable ground situation in your protagonist's 

life, which the inciting incident capitalizes on.  

The first turning point is at the end of the first quarter, and is an 

escalation scene that sets the plot spinning in a new direction.  

The midpoint ends the second quarter of the story, and involves a 

main character making a choice that will drive the second half of the 

story.  
Lazette Gifford, Editor 
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The second turning point ends off the third quarter with another 

crisis/escalation scene, leading up to the crisis, where the protagonist 

takes action.  

The black moment occurs right before the climax, near the end of the 

story. Confronted by the crisis, the protagonist faces another 

decision.  

And finally, the ending where the story concludes.  

Step 3: Flesh Out Your Idea With Character Work 

I still did not have a full handle on my plot, so I thought I would see if 

some character work would help me flesh things out a little. Those 

character questionnaires always seemed so random to me, so I 

thought that at this early stage, I would just free-write and see what I 

got. I wrote a brief paragraph for each main character, trying to touch 

on all the basics of appearance, motivation and backstory. 

Example: Emma is one of the two female leads. She was injured in 

the accident and has a long, deep scar on her face, which she is very 

self-conscious about, but she is otherwise extremely pretty. She was 
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wealthy and popular, but her family went broke paying her medical 

bills and her father deserted them. So she ran away to "the city" as 

soon as she was able to, and tried to make a fresh start.  

Shortly after arriving, she ran into fellow accident refugee Jonathan, 

who used to date her former best friend Sasha. He felt sorry for her 

and took her in. At the beginning of the story she leans more toward 

needing him than loving him, and he puts up with her numerous 

insecurities and difficulties because he feels guilty (maybe he was 

partially to blame for the accident?). The inciting incident of having to 

go home again will unhinge her -- not only is she is overwhelmed by 

everything she left unresolved, but she knows that Jonathan has 

been living in limbo too. When he sees Sasha again, will they resume 

where they left off?  

Most of this summary was merely a recap of some of the plot points I 

was trying to work though, but I did get a few interesting nuggets from 

it. The line about Emma "needing him more than loving him" intrigued 

me, as did Emma’s realization that Jonathan has been repressing 
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too. I was starting to get as curious as she was to find out what would 

happen when he reunited with his former flame. 

Step 4: Fill in as Many Plot Blanks as You Can 

By now, I had enough to work on the high points. So I opened up the 

word processor and typed out the headings, leaving five lines in 

between them. 

Unstable/Inciting 

* 

* 

* 

* 

* 

First Turning Point 

* 
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* 

* 

* 

* 

Midpoint 

etc. 

Then I filled in what I could, and gradually found the entire plot taking 

shape. Seeing, visually, how you only have five or so chapters to get 

from point A to point B, you can think sequentially: what needs to 

happen to get you there? I have two main viewpoint groups: Sasha 

and her sphere, and Emma and hers. Even if each girl only gets one 

scene per section, that still takes two of my five. Doesn't leave you 

much wiggle room!  

Evan Marshall, in his book The Marshall Plan for Novel Writing, 

suggests that every scene is either an action scene, or a reaction to a 

previous scene. That made a good starting point for me. I began with 
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the unstable ground situation of Jonathan learning that his 

grandmother has died and he must, after several years, return home 

for the funeral. The inciting incident, which takes advantage of this, 

was the idea that he was unable to find accommodations for Emma 

and himself on such short notice, and he is forced to call his ex, 

Sasha -- much to Emma's dismay. Now, according to my outline, I've 

got five chapters until my first turning point. Go!  

Scene 1---Reaction: Back in the hometown, Sasha shares the news 

with her boyfriend Cole, and over the course of the conversation, 

updates the reader on her own backstory. Although unharmed from 

the accident, she has had her share of traumas. Her mother died and 

left her teenaged sister Marnie in her care, and she has been 

scraping out a living working in Cole's restaurant. She confesses to 

Cole that Jonathan never said a proper goodbye when he left her, 

and Cole wonders how she will react to seeing him again.  

Scene 2---A migraine en route leaves Emma irritable when she and 

Jonathan arrive in town. The whole gang is a little snippy together, 

and when Cole shuts down on her, Sasha takes Jonathan for a walk 
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to clear the air between them. Meanwhile, back at the house, Emma 

finds herself unexpectedly bonding with Sasha's sister Marnie.  

Scene 3---Action: The morning after. Jonathan and Emma go to the 

funeral home to take care of business. Jonathan is dismayed when 

Emma can't keep her mind off Sasha. They argue, rehashing past 

insecurities, and Emma walks out on him, forcing Jonathan to call 

Sasha for a ride home.   

Scene 4---Reaction: Sasha and Cole come to get Jonathan. While 

Sasha confronts him about his grandmother, his past and his future 

with the grouchy Emma, Cole runs into the departing Emma and to 

his surprise finds himself opening up to her about his relationship with 

Sasha and his fears regarding Marnie's role in his relationship.  

Scene 5---Action: Emma and Jonathan take a night out to try to patch 

things up following their fight in the previous chapter. Sasha enjoys a 

quiet night of domesticity with Cole while Marnie is off babysitting, 

and Sasha surprises Cole by broaching the subject of their future and 

suggesting that they move in together.  
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And finally, we reach the first turning point all of this has been leading 

up to: Emma's date with Jonathan ends badly. As the gang settles in 

for one last uncomfortable night together before Jonathan and Emma 

return home, Cole is a little too grateful to escape the tension, and 

Sasha finds solace with an out-of-sorts Jonathan.  

I've got a healthy set-up for the rest of the story now. I have a turning 

point open for Emma to find out about Jonathan's little indiscretion, 

and another for Marnie to find out about Sasha's plans to bring a new 

dad into her life. I also have some tension available in Marnie's new 

bond with Emma. Just how is Sasha going to feel if a confused 

Marnie turns to her former rival for help? That could be a good 

midpoint: have a freaked-out Marnie run away from home, maybe, 

and go to Emma? This way I'll have to reunite the kids again (and on 

Emma and Jonathan's turf this time) for Sasha to come collect her.  

And what is it exactly that has Marnie so freaked out anyway? For 

this I re-scan my character description and remember my backstory 

for the girls. Sasha got saddled with custody of her sister after their 

mother died. So clearly the father was already out of the picture. 
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Dead? No, that would be a bit too tragic. Maybe he left them, and 

although Marnie plays the cool teenager, it obviously affected her. 

She fears bringing another father figure into her life because he might 

leave too!  

So there is my climax: they arrive to collect Marnie, and she finally 

comes clean with them about her true fears. After all this angst, a 

happy ending is, of course, mandatory. Let's leave them all happy 

friends again, coupled off as they should be. And let's get Marnie a 

puppy or something as a token of love from Cole. The end. 

As a final wrap-up to the planning process, I skimmed a few of my 

favourite books about writing for further inspiration. Then, with outline 

in hand, I was ready to go. It is easy enough to revise the outline if 

the story takes different twists than expected once the writing begins, 

and it is important to be flexible and ready for that possibility. But just 

knowing that you have enough to work with, and that there are 

logical, interesting and plot-driven ways to get from one part to the 

next can be a huge confidence booster and make the writing go that 

much more smoothly.  
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The proof? I have a finished draft of the above story, which may not 

be publishable, now or ever, but which served its purpose in teaching 

me a lot about the writing process. 

Book cited: The Marshall Plan for Novel Writing by Evan Marshall, 

1998, Writer’s Digest Books. ISBN 1-58297-062-9 
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Writing Novels 

By Jon Chaisson 
©2004, Jon Chaisson

 

How anyone can write a short story is beyond me. 

Don't get me wrong; I enjoy reading them.  But I've tried my hand at 

writing them and I just can't do it.  I can't wrap my head around one 

idea; I have to have five different subplots, a whole created universe, 

and an ongoing conflict that isn't easy to resolve within a few pages.  

I love to get lost in the flow of words.  In a way, it reminds me of my 

uncle who used to tell five-minute jokes that could be told in thirty 

seconds.  The journey is fun, and the payoff is always worth it. 

When I'm coming up with ideas, more often than not, just buds of 

inspiration or passing images that catch my imagination, waiting to 

take hold and grow.  Most of these ideas aren't deliberately conjured; 

they come from dreams, from music, from documentaries on 

television, or even from a sentence I happen to read in a book.  If an 

idea hits me at just the right angle, I'll get obsessed enough to take 
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out the ol' pad and pen and scribble everything down.  Within a few 

minutes I'll have the barest bones of a story.  The written notes 

become merely a guideline, and the rest of it hatches like an H. R. 

Giger alien inside my head, taking over and not letting go until it's 

migrated through my body and onto the computer screen. 

So how is it that these miniscule ideas turn into sprawling novels?  

Why can't I, just once, come up with an idea that can be contained 

within a few thousand words?  I've tried it once, and while it was an 

amusing story, I felt I was severely editing myself.  The characters 

had little or no depth, and the story itself felt shallow and ended up 

reading like a Japanese manga rip-off.  Ever since then I've devoted 

my time to the wonders of worldbuilding and character development. 

Writing a novel, I suppose, might be a little like composing a 

symphony.  There's a lot more to it than crafting a beautiful melody; 

there are complexities and structures that must be included for it to 

make sense and become a work of art.  A theme must be presented, 

a story must be told, and, most importantly, the whole work must 

remain interesting to hold the audience all the way to the end.  Both 
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symphonies and novels contain conflict, diversions, and repetition to 

hold the theme in place.  The art is in interweaving these three things 

into something unique and pleasant for the listener or reader to 

enjoy.   

This is the part of the craft I enjoy most.  It's almost a mathematical 

weaving, creating a flow that hides the framework underneath and 

exposes only the finished work of art.  It's during this weaving that the 

characters develop, the worldbuilding continues, and the composition 

takes on a life of its own.  There are many writers out there who have 

admitted to loving a part of their novel in progress, despite its going in 

a direction other than its intended path.  These happy accidents add 

to the story -- admittedly, sometimes to the detriment of the novel 

itself, but that's a given -- and often they reveal something 

unexpected about the story or the character.  The weaving takes on a 

new path while still remaining faithful to the theme.  I remind myself 

that this is the kind of conflict readers enjoy, so more often than not I 

roll with it.  As long as the overall theme is intact, I still have my story. 

This is the kind of evolution within the story that draws me towards 

Lazette Gifford, Editor 
vision@lazette.net 

60 of 147 



Vision: A Resource for Writers 
Issue # 20 

61
 

writing them.  With a novel I can learn about the characters just like a 

reader would.  I can play with their actions (and their minds) as much 

as I want, without sacrificing anything. 

*   *   * 

The need to sacrifice pieces of a novel, on the other hand, is a 

bittersweet job that must be done from time to time.  Excising 

passages that are no longer needed is one of the toughest things a 

writer has to do to his story.  During the writing process, scenes 

cease to fit within the context of the novel, for one reason or another.  

They may be 'diversions' that worked to develop a character, but did 

not contribute to the overall flow.  They may be the 'cool scenes' with 

all the bells and whistles that had no real reason for being there 

except for flash.  Or they may be subplots that did little except take up 

space.  A red flag pops up during the rewrite, and that queasy feeling 

sinks in with the realization that some surgery will have to be 

performed. 

I will admit that I have fallen victim to the 'cool scenes' and the 

'diversions' and the 'pointless subplots.'  We all have, as writers.  It 
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comes with the territory.  The first incarnation of my Mihari trilogy 

project, a long novel entitled The Phoenix Effect, was full of these 

things.  And while the novel made sense, all the extraneous items 

made my symphony sound like an out-of-tune school band, with the 

horn section playing too loud and the woodwinds stuck on an 

altogether different tune.  I had too many subplots going that were 

never wrapped up at the end.  I had too many characters with nothing 

important to contribute to the plot.  And let's just say that too many 

'cool scenes' strung together don't make a plot. 

I learned my lesson the hard way when I picked the novel up after 

many months of having completely forgotten about it.  While I had the 

germ of a novel within these many pages, what I didn't have was the 

symphony.  It sounded all wrong, if that makes sense.  By rereading it 

I could feel that there was no flow, and no life to it.  There were many 

parts of it that could be salvaged... if I sat down, took this novel 

writing gig a little more seriously, and completely rewrote it. 

Which is what I did.  I liked the idea too much to be rid of it and chalk 

it up as a trunk novel, so I took some time to further build both the 

Lazette Gifford, Editor 
vision@lazette.net 

62 of 147 



Vision: A Resource for Writers 
Issue # 20 

63
 

world and the characters.  I gave the setting life by giving the city of 

Bridgetown a culture.  I dropped an embarrassing subplot of artificial 

intelligence and substituted an alien race with ancestral ties to 

humans.  I gave this alien race its own spiritual culture and its own 

language.  If I was going to do this novel right, I was going to go all 

out, damn the torpedoes, full steam ahead.  Using the original only as 

a guideline, I started at the beginning and gave it as much life as I 

could. 

Next thing I knew, I was one-third of the way through The Phoenix 

Effect and I had a full-length novel of over 150,000 words, entitled A 

Division of Souls.  At first this shocked me.  Had I gone overboard?  

Once I did the rewrite, it was clear that I hadn't; in fact, I wrote the 

novel I'd meant to write the first time out, only as the first book in a 

trilogy. 

Again, there were many scenes that had to be excised.  Most of them 

were edited out due to the fact that I was merely writing a repeat of 

an earlier scene.  Others were cut because of change in the plot.  Of 

course, being the packrat that I am, I sent these parts off to a folder 
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on my computer called 'Outtakes.'  I even annotated a few of them to 

show where they might have gone, and also to show the difference 

between the first draft and the final rewrite.  I did the same for books 

two and three, The Persistence of Memories and The Process of 

Belief.  I'm currently working on book three, and the plot has diverged 

so much from the original that I'm no longer using it as a guideline.  I 

might steal a few scenes from it, but other than that, I can say this 

trilogy has taken on a much healthier life of its own. 

*   *   * 

One last thing. 

Anyone who's seen my posts in the Forward Motion Community 

might have noticed that I have not one, but four WIPs (Works In 

Progress) going on at the moment, aside from this third novel.  How, 

you ask, can I possibly find the time to write five novels at once?  I 

ask myself that question all the time. 

I know once I finish off the third book, I won't be touching this magical 

universe again, at least for a long time.  I believe I can tell the story I 
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want to tell within those three books, and a fourth would stretch the 

idea farther than I want it to go.  If you asked me eight years ago 

what I'd do after I finished a novel, I'd have had no idea what to say.  

Back then, starting a new novel was starting from a completely clean 

slate. 

Since then I've learned to multitask my writing.  While I concentrate 

mostly on this current novel, those four WIPs are in the back of my 

mind, just waiting to be next in line.  I haven't forgotten about them; in 

fact, I'll often write down notes as they come to me at work.  But for 

the moment, that's all they are: notes.  What I'm doing here is saving 

time.   I'm worldbuilding, just like I did with the trilogy rewrite, only I'm 

doing it while I'm writing something else.  This, by far, is one of the 

most important abilities a writer should have.  Why wait for something 

to be completed, only to waste valuable writing time doodling for 

ideas?  I say do it now; let the ideas germinate for awhile!  By the 

time I eventually do pick one of them up, I'll have enough of the 

framework to build yet another novel. 

Or in this case, write another symphony. 

Lazette Gifford, Editor 
vision@lazette.net 

65 of 147 



Vision: A Resource for Writers 
Issue # 20 

66
 

NaNo Reflections 

By Peggy Kurilla 
©2004, Peggy Kurilla 

 

Following the advice to try anything twice -- to be sure you like it -- for 

the past two Novembers, I have joined the collective madness of 

National Novel Writing Month (NaNoWriMo, or just NaNo).  Now, 

having completed the second 50,000 word dash, it's time to reflect on 

the experience. 

Obviously the first thing to consider is productivity.  The challenge of 

NaNo is 50,000 words on a new novel within thirty days.  Both times, 

I completed a very rough first draft of a novel:  in November 2002, I 

wrote Nemesis, a contemporary fantasy; in November 2003, I wrote 

From the Depths, a paranormal romance.  The drafts are short -- 

50,100 words for Nemesis and 52,000 words for Depths -- and 

unsalable at their current length, but I am proud that they're 

completed, because before them I had only written a draft of one 
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story at 45,000 words.  For a beginning writer, NaNo might provide 

the spark to actually complete a draft of a novel. 

Which leads into the second point:  NaNo requires an average of 

1,667 words per day.  For those who go by page count, that's almost 

seven pages a day.  At least one commentator said, in effect, 

"Anything written that fast can't be good."  What this person has 

overlooked is that many professional writers write at that pace 

regularly; some do less, and a few do more.   

In my experience, however (especially since I have a day job that can 

be demanding), a consistent 1,667 words per day is almost too 

many.  There were days when I would get a solid 1,000 words before 

I left for work, and then come home knowing that I must write nearly 

700 more to stay on schedule.  That can be mentally draining, 

especially when things didn't go as well as they could have -- like the 

Friday that I had 900 words before going to work.  Outside of NaNo, I 

would've felt proud of myself for getting that many and not worried 

about it.  However,I ended up having to stay at work until after 8:00 at 

night and got home around 8:30 to find that some friends had 
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dropped in.  I wasn't able to enjoy the time with my friends because 

those last 767 words kept nagging at me.  By the time my friends left, 

I was too tired to write, and went to bed, leaving myself with a goal for 

Saturday of more than 2,400 words -- more than double my normal 

daily count. 

A third point:  NaNo allows, and even encourages, advance 

preparation work like outlining, character studies, and whatever the 

author wants to do besides writing on the story itself.  That's good, 

because without an outline, I don't think I would have completed 

either story in the allotted time.  That time constraint, however, can 

present a different challenge as well. 

As usually happens when I write, my subconscious kept sending me 

messages: "Wouldn't it be neat if...? And, hey, you missed this point 

about..."  And I put them in.  That's my fault (if a fault it is) but the 

speed and pressure of NaNo don't allow for the deep thinking time 

that might have let me see where I needed to take those add-ins and 

work with them both before their insertion and afterwards to keep the 

story coherent. 
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Partly as a result of these additions, both of my NaNovels ended up 

having to be substantially revised, almost to the point of throwing 

them out and starting over.  I can't say for certain that I would not be 

facing the same rewrites if they were not NaNovels, but I suspect that 

given the "dreamtime" to work with ideas from my subconscious, 

rather than throwing them down as a way to make the wordcount goal 

for the day, the revisions would be less daunting. 

Am I going to participate again next year?  Maybe.  It's great fun, and 

knowing that there are thousands of other people doing the same 

crazy thing that you are is inspiring and heady stuff. 

What will I do differently the next time I participate?  First and most 

importantly, I'll do a lot more pre-writing than I have for the last two, in 

an attempt to work out some of those "But what ifs" in the outline 

stage rather than during the actual draft writing.  I suspect that means 

that I'll be playing with the outline beginning sometime in September, 

but if it helps me avoid the frustration of having to almost totally 

rewrite a project, it'll be worth the energy. 
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Second, I'll make a big sign and tape it to the wall over my computer 

to remind myself that it's only writing.  If I don't make the 50,000 word 

goal, I'll still have made forward motion.  And I shouldn't feel guilty for 

spending time with my friends instead of writing, even if it means I 

"fall behind" by a few hundred words. 

But that's for next year.  Right now, I have a novel to rewrite. 
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Conquering Writer's Block 

By J M Edwards III 
©2004, J M Edwards III 

 

This article will show you a step-by-step method of kicking writer's 

block to the curb.  We shall look at the basis of your writer's block and 

how to get past it.  Be prepared to step outside your boundaries to 

accomplish this.  You have the skills to do it.  DON'T PANIC!   

No technique is guaranteed; however, I use this method myself and 

have shared it with several other authors who, for some reason or 

other, couldn't get that next word on the page.  One of the things you 

must do is be completely honest.  If you have an issue that you are 

not ready to address, this article will not be able to help you much.  

With that said, let's dive in. 

What is the cause of your writer's block? 

I break this down into two areas: problems related to the writing and 

problems not related to the writing.  Ask yourself the following: 
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••  

••  

Are there any outside pressures that are distracting me 

from my writing?  If not, move on to the end of this list. 

What steps I can take to resolve these issues? 

The key here is to itemize each step in resolving each issue.  After 

you itemize, put a goal date next to each step (you may say 

“immediately”; in this case, stop writing and do it).  This is the date 

you anticipate completing the step.  By assigning dates, you are 

making a commitment to yourself to get these issues resolved.  This 

in itself should relieve some of the pressure that is causing your 

writing to suffer. 

��            Type up the solutions to these issues and add them to 

your daily word count.  This can help you keep up with 

your word count goals and alleviate some of that 

pressure. 

If outside pressures are not the problem, then we must assume there 

are issues with the story.  You have written yourself into a corner.  

Your characters are no longer speaking to you.  The compass you 
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have been using to direct your story is suddenly broken.  Whatever 

the problem is, the outcome is that you are no longer writing your 

story. 

Don't stress!  There is something you can do about it.  The idea is to 

locate the place in the story where the writing began to stray and fix it 

from there.  This is how we go about it (yes, more questions).  Read 

through all of the steps quickly, then follow the directions at the end of 

the list. 

��            In ten words or less, how does your story end? 

��            In ten words or less, what is your theme? 

��            In one hundred words or less, describe what has been 

happening in the last two chapters to the characters 

involved in this chapter. 

��            In one hundred words or less, describe what is going to 

happen in the next two chapters to the characters 

involved in this chapter. 
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You may stop answering as soon as you have an inspiration.  You 

should be able to complete this in fifteen minutes or less.  GO! 

If you could not complete these four steps in fifteen minutes, the 

problem may lay farther toward the beginning of the story.  Is this 

where you want your characters?  Have your characters strayed from 

their original motivations or from the themes of your story?  What 

needs to happen for the characters to get to the next chapter?  To the 

end of the book?  Again, write or type all of this out and add it to your 

daily word count. 

If you are still stuck, you may need to conduct character interviews, 

outline revisions, or a reassessment of your theme and plot.  

Whatever you do, keep writing.  That's how this article came about.  

Good luck. 

By the way, I'm not stuck anymore. 
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Keys to Great Endings 

By Crista Rucker 
©2004, Crista Rucker 

 

A perfect ending: everyone one has read at least one and, as writers, 

we all strive to write one. The ending is the checkered flag of the 

writing journey and the culmination of the hours of blood, work, and 

joy that go into creating a novel. One would think that the ending is 

the point where a writer could begin to relax. After all, the worst of the 

work is over, right? You've agonized over the characters' every 

nuance and you've hammered the events of your plot into a coherent 

order (or incoherent, if you happen to be a Surrealist); it should all be 

downhill from here.  

Yet, if you're anything like me, you fret over the finale to your work 

just as much as, if not more than, you did over the opening or the 

characters. It is a precarious balance between writing a killer finish to 

your novel and creating an ending that will send it hurtling towards 

the nearest wall. If you look at the endings of your favorite books, you 
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might find that there are certain keys that most great endings have in 

common.  

The first and most important key to a great ending is inevitability. 

When a reader finishes your novel, she should feel like there is no 

other possible ending that would fit the book. Writers such as China 

Mieville, with his critically acclaimed novel Perdido Street Station, 

seem to have mastered this concept. The ending to this novel is grim 

and sad, but if you sift through the scenes leading up to this climax, 

you see that there really is no other possible way the novel could 

have ended without destroying the themes and invalidating the 

scenes that built to the climax. Even in surprise or twist endings, 

which are currently very popular, it is fun for a reader to re-read the 

novel to see how each scene interlocks and weaves the pattern that 

will become the ending.   

The point to remember in creating an inevitable ending is to plot your 

novel so that every scene reflects how the novel will end. Even 

scenes that belong to a subplot or exist merely for character 

development should provide a small insight as to why the ending 
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occurred and why, given the characters, setting, and prior plot points, 

it is the only one that fits. The easiest way to do this would be to know 

the ending before you start to write or plot your novel, but this can 

also be done in the revising stage once the final outcome is known 

and all the scenes are written.  

Another key to great endings is to ensure that the characters' actions 

create the ending. The ending should come as the result of a choice 

that the main characters make. Every action and interaction, even 

down to every word of dialogue, whether your characters are talking 

about what to eat for breakfast or hashing out a plan to murder the 

villain, should foreshadow that final choice. This ties in with that 

sense of inevitability and is the prime method used in Mieville's novel 

to construct his ending.  

The third key to creating a great ending is an ending that actually 

ends. While this may seem simple in stand-alone novels, what can 

writers do if they are writing a trilogy or an ongoing series? These 

types of books are very popular right now and the readers want to 
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buy the next book to find out what happens next. So how does this 

suggestion apply to those type of books?  

If you are working with a series, at the end of every book, something 

must end. Most popular series have multiple plot threads and 

numerous subplots, so finding something to finalize shouldn't be too 

difficult. A reader usually doesn't want to tear through 400+ pages of 

a novel only to come to the end and discover that nothing is resolved.  

Take for instance one very popular fantasy series, George R.R. 

Martin's Song of Ice and Fire. In the latest novel, A Storm of Swords, 

while the ending doesn't tie everything up, most of the characters are 

brought to end of their current circumstances. They are introduced to 

new adventures, so the readers know that when they pick up the next 

novel in the series, they won't be reading about the same exact 

circumstances as the last. It will be something new and different. This 

makes the end of this particular novel in this series successful.  

Now that I've listed a few keys to successful endings, what factors 

can make for those endings that make the reader want to toss your 

novel directly into the trashcan? First and foremost of these is the 
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ending where nothing changes. Most readers don't want to reach the 

end of the novel and find that everything stays the same. Something 

must change. It can be as subtle as a shift in the character's 

personality and emotional state or as dramatic as a complete change 

in a political system.  

This factor ties back into the keys about inevitability and the 

character's role in the ending. If your character is the one guiding the 

novel, then it is inevitable that there will be some sort of change in 

this individual or in her circumstances. If there is no change at all 

from the beginning to the ending of your novel, then what was the 

purpose of your work other than to string a bunch of scenes together?  

A device to avoid when constructing your ending is the ending by 

chance, otherwise known as Deus ex Machina. While the Greeks 

employed this often in their plays, in modern fiction, it is nearly 

impossible to do without frustrating the reader. For example, in a 

novel about a spunky princess' efforts to defy the evil warlord trying to 

take over her kingdom, if during the final face-off said warlord dies by 

a fatal heart attack or some other natural phenomenon in which the 
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heroine had no part, then the reader is going to feel cheated out of 

the climactic battle between the two that you have been building 

since page one of your novel. This is likely to result in the previously 

mentioned occurrence of your novel hitting the bottom of a trash 

barrel. 

Satisfying endings are one of the many challenging aspects of novel 

writing, but well worth it if done successfully. They can keep readers 

coming back for more. Remember, the ending is the last chance you 

have to impress your reader before they pick up your next book. Do 

you want to wow them or leaving them feeling dissatisfied?  

China Mieville, Perdido Street Station, ISBN #: 0345459407 

George R.R. Martin, A Storm of Swords, ISBN #: 055357342X  
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The Freedom to Write 

By Lazette Gifford 
©2004, Lazette Gifford 

 

The story haunts you from the first glimpse of the character 

standing on the mountain cliff, looking out over the world that 

rolls away in folds of green forest and naked stones beneath 

her.  Perhaps there is a distant village that you can sense more 

than see. You're both startled.  Is she going to jump?  Why? 

Will you ever know? 

This is a pep talk for all of you who have trouble seeing a novel 

project through to the end.  If you want to write novels and yet find 

yourself stopped at one of the many steps along the way, take heart.  

You are far from alone. 

But you can get through the morass of work if you just focus on one 

important thing -- You are the only one who can tell this story, and if 

you don't, it will be lost forever. 
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Does that sound frightening?  It shouldn't be.  It should make your 

soul sing to realize that the story you have in your head is your 

personal gift.  You can write it for yourself.  You can write it for 

others.  But no one can write it for you, and that's good.  Creating a 

novel is one of the most wonderful, creative experiences a person 

can have.  Okay, maybe I'm a little biased... but if you are reading this 

article, it probably means that there's a part of you that wants to write 

novels.   

The first step is to give yourself permission to enjoy writing.  Because 

of the western prejudice that enjoyment can't be work, and only work 

is important, we tend to make writing more difficult than it need be 

just to prove its worth.  Let go of that fallacy of work and enjoyment 

right from the start. 

But that still leaves you with the actual process of creating a novel.  It 

seems that the writing usually follows a certain pattern.  Most start 

with either an idea or a person, and sometimes both.  Unfortunately, 

too many get stopped somewhere along the way by one fear or 

another that the work is not right. 
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We've all been there. There's nothing to be afraid of when you write a 

book. They are only words on pages or screens.  Few stories are 

ever totally perfect, but that shouldn't stop you from telling the ones 

that have come to you. 

Having a story to tell is a gift that is not given to everyone.  The more 

stories you write and complete, the closer you are going to get to 

telling the perfect tale.  This is an art that takes practice, and no one 

ever made perfect art by stopping in the middle and never finishing. 

The Beginning 

If you are like me, the first single vision (like the woman standing on 

the cliff) will take hold and grow by leaps and bounds before you can 

even get a handle on what's going on.  You have no idea who she 

might be, but you can already see the enemy skulking in the trees 

behind her. 

Step One 

The first steps in novel creation are usually the easiest.  The 

excitement will drive a writer on through the who and why part.  It's 
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when we reach the what -- the worldbuilding -- that things slow down, 

even if worldbuilding is the part the writer loves most to do.  You 

cannot rush worldbuilding. 

Perhaps this is the part that stops you because worldbuilding looks 

too frightening.  You want to write an intricate fantasy story about 

mystical creatures, fantastic magic, breathtaking romance, and all set 

in a world that is unlike our own.  However, every time you sit down to 

sketch things out, they either seem mundane or a cliché. 

That's because nothing you write out in worldbuilding notes will ever 

be as exciting as it will be when you put it into the novel and work 

with it in the storyline.  You're just painting the backdrop for the play.  

Until you put the characters in their places, it's not going to be a 

setting.  It is not the story. 

And everything is a cliché and has been used before.  Get used to 

that idea.  It is not the components of the story that make them -- it is 

the tale you tell using the tools we all use. 
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Just tell your story and use whatever pieces of story telling that you 

need to do so. 

Step Two 

Either before or after worldbuilding comes the note taking, scene 

creation, outlining -- there are several steps that most writers take 

before they plunge into the work. Unless you just begin writing with 

the knowledge that you'll be rewriting extensively in the next draft as 

everything comes together, putting the plot in order is going to be an 

important part of the pre-writing. 

Oh, and there it is again -- the feeling that the plot isn't exciting 

enough, or you've read the story before, or... 

Just press on through the work.  Stop sabotaging yourself before you 

get to the actual work.  You have a story to tell.  Don't look for 

excuses not to do so. 

Writing 

While writing the novel is usually the hardest part of the work, it isn't 

always the part that gives authors the most trouble.  We are story 
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tellers, and this is the part that draws most of us to the work.   

We want to write out the tale of the young woman and everything that 

happened to her until she finds herself on that cliff side, making a 

final decision about life.  We aren't -- or at least shouldn't be -- afraid 

of those words that we put down on paper or the computer screen.  

Writing the novel should be the part that we are striving for. 

But writing takes time and dedication.  Once you start the novel you 

know you have committed yourself to a long, difficult process that is 

only half finished when you reach The End.  The first few pages look 

impossible to write properly, and the ending looks so far away that 

you'll never reach it. 

First, let me give you a word of warning about the opening to a novel.  

Don't dedicate too much time to those opening paragraphs, because 

chances are by the time you get to the last lines of the novel, there 

are going to be substantial changes in what you first imagined, and 

that opening is going to have to change to reflect them.  This 

happens even to people who have written out extensive plots.  This 

ties back to what I said about worldbuilding and outlining; neither are 
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actual story writing.  All the preplanning in the world will not create a 

story, nor will it guarantee a perfect story in the first draft. 

Write the opening you imagine is best and move on.  You'll have a 

chance to change and improve it still.   Don't worry. 

Some writers see the opening and the ending, and the flounder in the 

middle.  Outlines can help in this case.  And also remember that a 

story is a single piece, not really three parts.  What happens in the 

opening leads to the middle, and what happens there leads to the 

end.  Put obstacles between your characters and the ending of the 

novel.  That's how you build the middle.  Don't give up just because 

you hit a spot that's a little more difficult to work through.  Don't give 

up just because you've gotten bored and want to work on something 

new.  Those are easy outs, and a good way to never finish anything 

at all. 

Make yourself sit down and write. That's really the hardest part of all -

- giving up time you might want for something else to do the work.  

But if you have a story to tell, then do it.  Don't give up. 
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Editing 

For those who make it all the way through the first draft, the idea of 

editing the work is a barrier they can't overcome.  They've told the 

story, and the idea of reworking it into a better version sounds boring. 

Editing is a gift to writers that allows us as many chances at the same 

piece of art as we like, and all without having to recreate it from 

scratch.  If a painter finds that the sky is the wrong color of blue, or 

the woman whom she painted into center stage is too tall, there are 

only so many tricks that she can do to change it before she has to 

scrap the painting and start over.  We do not have that problem.  We 

can recolor the sky, change the shape of the mountains, and change 

that woman at center stage as often as we like. 

Editing is the writer's most important tool.  It can even be a fun and 

exciting tool if you look at it as a way to make the story closer to what 

you wanted.  Tweaking is a joy if you focus on the small pieces and 

not worry about how much you have left to do. 

If you have done all the work of writing, don't stop now!   
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Submitting  

The final and most frightening step is the idea of turning your story 

over to someone else who may not want to publish it.  In fact, 

chances are that they are not going to accept the novel the first time 

you send it out.  Or the second.  You may find that you have to write 

four or five more before someone shows an interest. 

You have not wasted your time.  Remember, writing is an art that is 

learned through practice as much as it is by learning the technical 

aspects.  Most writers must go through all the steps -- not just a few 

of them -- several times before they find that they can write saleable 

material. 

If you have a story to tell, it's not going to matter if the first attempts 

don't sell.  And here's another bright point for writers:  A few years 

down the road you're going to know more about writing than you did 

when you started that first novel.  You're going to be able to look at it 

and realize what you could do differently now, and you can still fix 

that first story.  No writing is ever wasted.  However, the only way to 
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reach that point is to move past the creation of the first novels.  You 

can only learn to get better by doing the work. 

  

Take up the challenge and leap into the work of writing your novel.  

It's going to be a long haul, but you can do it if you just remind 

yourself that you have stories to tell, and that's where the real joy of 

writing lies. 

And there you are, back to the cliff and your character.  She's 

still waiting there, looking down at the trees and stone and 

hearing the enemies behind her.  Or are those only her 

personal doubts, whispering in her mind?   

It's time for her to spread her wings and fly. 
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A Little Bit of Science... 

By Kate Paulk 
©2004, Kate Paulk 

 

...makes your fantasy go round.  

In my experience as an as-yet-unpublished fiction author and a 

member of several critique groups, one of the biggest mistakes new 

fantasy writers make is substituting magic for serious plotting. If a 

character can do anything with magic, there's no need to show other 

reasons why she could do what she did. She can rescue the 

protagonist from an impossible situation without breaking a sweat, 

then go and do something equally miraculous for an encore.  

Not only does this destroy the credibility of a plot, it also violates more 

laws of science than I care to think about. Those laws are 

encapsulations of "how things work" rather than decrees from On 

High and if the rest of a fantasy world follows the laws of science, 

then the magic had better do so too. 
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Let's consider what would happen if just one law of science didn't 

work. I'll take one of Newton's Laws -- "For each and every action, 

there is an equal and opposite reaction." What this means (for those 

who suffered from indifferent science teaching) is that if you push on 

something, it pushes back just as hard. To make it move, you have to 

push harder than it can push back.  

Now, suppose that wasn't the case. What then? First we need to 

consider the options. Does the reaction vary at random or to a 

consistent pattern? Is it always the same or not? Is it greater than the 

action or less, and by how much? What rules, if any, apply?  

For the sake of argument, I'll say that it varies randomly between all 

possible extremes. This means that every step becomes an 

adventure. With one step you could get bounced into orbit. With the 

next, the surface under your feet collapses. In the meantime, you're 

trying not to die, because every time your heart beats anything from 

blood vessels rupturing to them collapsing could happen, and 

probably will. Your skin is leaking because every time a blood cell 
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bounces against a capillary wall it could rupture and the effect of 

millions of blood cells has left your blood vessels a porous mess.  

In short, it doesn't work. 

I find that trying to fit magic to scientific laws -- and treating magic as 

a science -- gives much more interesting results. Not only does magic 

become more versatile, I'm forced to be more imaginative about how 

it's applied. It is truly amazing what can happen when you combine 

the basic laws of physics with the application of magic. 

Thermodynamics and magic are a good combination, too. For a start, 

they can be used to develop a magic system that is rigorous enough 

to be believable, while still allowing the odd surprise.  

If magic follows scientific rules, then some of the consequences can 

include miscast spells rebounding on the caster with as much force 

as they'd have had if they'd been done right, a magic user needing to 

apply the appropriate push to make the spell work -- and being 

appropriately tired afterwards -- reflective magic that bounces spells 

back to the caster at the same angle as they hit the mirror, spell 

energies that are unique to the caster because they came from a 
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unique individual... The possibilities are endless, and much more fun 

than unlimited hand waving magic. 

Besides, when you've got a magic user who knows that a little shove 

here is all it takes to make the volcano outside town blow up, you've 

got a really dangerous antagonist -- and that's what every plot needs. 

Taking this idea further, while remembering that with very few 

exceptions lava from continental volcanoes flows slowly (look at 

footage of the Vesuvius eruption in late WW2 for a good example) 

and the real danger is from ash and flows of superheated gas mixed 

with partially re-melted ash particles, we have the beginnings of a 

magic-based plot. 

The antagonist -- let's call him EO for short -- holds the townsfolk as 

his virtual slaves, because he can cause an eruption at any time. He 

can also loosen things up to prevent eruptions he doesn't want, 

working a bit like the regulator on a pressure cooker.  

The protagonist naturally wants to free the town from the EO's 

clutches. He has to find another way of controlling the volcano, which 

means he's got to find himself a magic user willing to resettle in town 
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and devote part of his time and energy to playing regulator. He's also 

got to find a way to take EO down.  

In the meantime, EO can make life very difficult indeed for Our Hero. 

EO is smart, so as soon as he finds out Our Hero is sniffing about, he 

cranks up the propaganda so that people don't want Our Hero to 

rescue them. Then he can use magic to make Our Hero's search for 

a willing mage difficult -- all without violating the laws of science. 

Enough water diverted into a sandy streambed will make quicksand. 

Fruit can be poisoned (EO is evil, he doesn't care about collateral 

damage), and so can standing bodies of water. Sharp pointy things 

can be arranged beforehand on the main road to the city so that they 

can be launched when Our Hero is in range. 

Anyone who has seen the movies remembers the scenes in The 

Empire Strikes Back and Attack of the Clones where the Force is 

used to hurl heavy objects around as though they were made of 

Styrofoam. Why bother when you can remove the support from a 

section of ceiling with much less effort? A few key nails, the keystone 

of an arched doorway, and splat. Gravity will do the rest of the work 
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for you. Naturally, EO would make use of this knowledge in the 

Ultimate Confrontation, possibly even injuring Our Hero.  

What makes this (admittedly rather crude) scenario more believable 

than the all-powerful magic user who can only be stopped by some 

obscure weakness? It makes sense. Even if you don't know science, 

you can watch how the story unfolds; the magic slides in under the 

credibility threshold without a trace because it's leaning on all the 

rules we see working every day of our lives.  

At some level every one of us believes that if we do something 

extraordinary, we should be correspondingly worn out. It doesn't 

matter if the extraordinary deed is climbing Mount Everest, running a 

mile in under four minutes, or casting the spell to banish all evil from 

the face of the Earth. We should be exhausted. Climbing the hill out 

the back or running a mile in ten minutes or banishing a minor demon 

shouldn't tire us out as much, but we should still feel it.  

So dig out those old Junior Science texts and take a look at the 

principles they teach. Look up information on the Internet. Apply 

some of the principles to your magic, and see what comes out. At 
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worst, it'll be fun. And who knows, it just might be what's needed to 

breathe new life into that trilogy sitting on the hard drive. 
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Brothers and Others:  

Creating Aliens that Aren't Alienating 

By Kat Feete 
©2004, Kat Feete 

 

The alien fascinates us. Tolkien's elves, Asimov's robots, Niven and 

Pournelle's Moties: they all serve the same essential function - to 

draw us outside ourselves and present us with something that is 

other. Compelling aliens are bulwarks of science fiction and fantasy 

which entice readers back again and again. 

But what fascinates the reader often frustrates the writer. On the one 

hand, it is both unwise and exhausting to allow the aliens to 

overwhelm the story.  Hardened science fiction readers may be 

willing to follow your thought experiment through to the bitter end, but 

most readers will grow bored of technical details and aliens so 

strange that they cannot empathize with them -- particularly when 

writers become so fascinated by the aliens that they forget to lavish 

the same care and attention on the humans in the story. On the other 
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hand, modern readers are also demanding about the details of aliens. 

Bug eyes and feathered crests are no longer enough to make an 

alien; pointy ears and a lisp cannot make a convincing elf these days.  

Unfortunately, writers seeking a balance between the familiar and the 

alien too often achieve only the mediocre. Almost always (save 

perhaps in hard science fiction) they err in making their aliens too 

human, falling back on three main tricks to keep their readers, and 

themselves, from noticing that they are writing about humans in funny 

costumes. 

The Unsatisfying Alien 

The first unsatisfying alien is created via simple subtraction or 

addition. Star Trek's Spock is a famous member of this clan; he is a 

human with the emotions subtracted. Other writers have subtracted 

dreaming, lying, a sense of humor, the imagination, dying, the ability 

to commit murder, and varied other abilities that can be used to 

define "human." Or perhaps the alien is just like a human save that 

something has been added: an extra sense, an extra sex, an extra 

head.  
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The formula can be a valuable tool.  In The Left Hand of Darkness, 

for example, Ursula LeGuin took humans but subtracted the gender, 

thereby creating one of the most controversial science fiction novels 

of the time. LeGuin herself, however, later said of the novel "In other 

areas... I see now a failure to think things through, or to express them 

clearly." And for every author who produces a brilliant but flawed 

alien race, there are at least a hundred who fail to carry through at all. 

The fact that the alien cannot dream, lie, die, etc., will be thrown in 

when the author wishes to make a point or a joke, but the rest of the 

time the alien will act human. Its society will be essentially human. Its 

culture will be remarkably human. Little or no thought will have been 

given to what the missing or added element would have done to, say, 

the structure of their government. 

The second unsatisfying alien is static and homogenous. Civilization 

thrives on challenge and difference, but this alien is based on one 

particular Earth culture or one particular Earth creature; it therefore 

lives in one particular habitat -- desert seems to be the favorite for 

science fiction, forest for fantasy -- and has one type of government, 

one religion, one set of cultural values, and one ethical stance.  
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Moreover, all members of its race look pretty much alike. Of course, 

one non-humanoid alien is likely to look much like another to a 

human, but oddly it's the humanoid aliens that lack the most in 

diversity. Diversity is a necessity. Specialization kills. Even if it 

weren't scientific fact, it would still be good sense.  Homogeneity isn't 

only a poor evolutionary strategy -- it's also immensely boring.  

The third unsatisfying alien is being used to prove something. The 

authors that write these aliens have abandoned good characterization 

entirely in favor of political commentary and grandstanding. Their 

aliens may be markedly inferior to humans (a cautionary example) or 

markedly superior (a positive example), but in either case, they exist 

only to tout the author's views on war, politics, religion, sex, race, the 

environment, art, or any of a thousand other transitory soapboxes. It 

hardly matters. These platforms, once rendered through the voice of 

a cardboard alien puppet, are all equally uninteresting. Readers do 

not like being preached to; they will grind their teeth at every platitude 

and throw the book down rather than read the pointed speech. The 

only readers these authors impress are those who already agree with 

them. 
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These three aliens may occur one at a time or all at once. Often they 

are well-intentioned. Frequently they have moments of salvation, 

where the aliens become, if not good aliens, at least good characters. 

But mostly they are fatally flawed. They are alienating, not alien; they 

are not human, but only because they are less than human. "If you 

deny any affinity with another person or kind of person," Ursula 

LeGuin wrote in her book The Language of the Night, "if you declare 

it to be wholly different from yourself… you may hate it or deify it; but 

in either case you have denied its spiritual equality and its human 

reality." Working that backwards, if you hate or deify your aliens, if 

you deny them a full, human reality, then you are denying your affinity 

with them - yours, and your readers'. You are preventing your readers 

from empathizing with your nonhuman characters, and, by doing so, 

you are damaging their ability to empathize with anyone in your story. 

Following Through 

My three examples of bad alien creation are not definitive - there are 

plenty of other ways to ruin a story. Nor can they be properly referred 

to as mistakes; aliens with elements of any or all of these have been 
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made into some of the most fascinating and compelling creatures in 

science fiction and fantasy. When writers think about what they are 

adding or subtracting, when they work to embed their beliefs into their 

aliens, the results can be dazzling -- and the problem of homogeneity 

tends to then solve itself, the complexity appearing naturally as the 

author's commitment to the alien deepens.  

This makes the reverse equally true. If an alien race, whether fantasy 

or science fiction, shows no diversity of culture or government, then 

its alienness is probably a graft and not a deep and integral part of it. 

If the habitat, the appearance, or most especially the personality of 

the whole race can be summed up in a word, then that race is not yet 

a finished one. After all, if Klingons are violent and dwarves are dour, 

then what are humans? Can you contain the personality of the human 

race in a word? If you can, then abandon the aliens for the moment 

and concentrate on your human characters. There is something very 

wrong with your story. 

But why go to all this trouble? Why fight and swear and sweat to 

create something which, by its very nature, will never be fully 
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understood by you or your readers? 

 It is interesting to note that all of the methods I list above -- denying a 

particular thing or adding one, demonizing or deifying, insisting that 

really they're all the same -- have, at various times, been used on 

women, animals, people of a different religion, people of a different 

country, people of a different skin color, and any number of other 

groups.  They have been used to generally deny rights that men, 

humans, people of the "correct" religion, et cetera, were considered 

entitled to. Fear of the other runs deep in us. But we are all aliens, 

trapped in our own minds and lives. Fiction writing is the art of 

creating a mind and letting other people traipse about it in for a bit, 

letting them recognize this or that -- "Yes, yes, I've done that, I've felt 

like that!" -- but also presenting them with incomprehensible actions 

or emotions, in the hopes that they may understand what they don't 

feel. Succeed in this, even in a very modest way, and you have 

written; fail in this, and you have done nothing of particular value.  

Writing about aliens is stretching the boundaries of compassion 

further than ever before. It's a goal that is worth a little work. 
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Microsoft Help Files: 

Using Microsoft Word to Cut Though the 

Hesitation Shuffle  

By Russ Gifford 
©2004, Russ Gifford 

 

As a writer, I've got my issues - and no, I'm not talking about 

publications. I've amassed lots of sales, but I have to face my 

difficulties every time I sit down at a keyboard, and I'm not alone in 

this world. "Stumbling block" doesn't describe the problems some of 

us have getting started on an article. Not the research, or the 

interviews, but actually getting into the groove to type the darn thing. 

Other writers confront difficulties moving from the final draft to the 

professional manuscript.  

I call this the Hesitation Shuffle. Perhaps it is the writer's equivalent of 

stage fright! It could be the fear that as writers, we are about to 

"commit literature!" Either way, I suspect the shuffle strands more 

potential writers short of home plate than any other problem.  

Lazette Gifford, Editor 
vision@lazette.net 

106 of 147 



Vision: A Resource for Writers 
Issue # 20 

107
 

If the shuffle seizes you on a regular basis, I have good news! Just as 

Microsoft Word rescued us from the tedious chores of error 

corrections and spell checking, (see Vision 19, Microsoft Help Files: 

Five Important Tools in Microsoft Word), we can also use this premier 

word processing program to automate our writing efforts. We can 

create a professional final manuscript, and help us work with requests 

for re-writes and references, too. Let's get started! 

Guidelines for Submissions 

The first step to overcoming the fear of committing literature is to 

make certain you look like a professional every step of the process. 

Luckily, book and magazine editors do their best to encourage new 

writers, including posting their magazine's needs, and their specific 

guidelines for article submissions. Generally speaking, the guidelines 

are very similar, and all are designed to help the editors slog through 

the incredible amounts of copy without losing the vital connection to 

the author. Nearly all guidelines request your full name and address 

on the front page, double space for the body of text, and your name 

and a page number on each of the pages. Nothing too major, but very 
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important. While you might get by violating these guidelines, realize 

doing so tells the editor they are dealing with an untested writer. Most 

editors want copy changes, or sometimes, a new twist to the story 

you've submitted. Working with a seasoned pro, they have reason to 

believe if they invest the time to tell the writer what they want, they'll 

get it. However, if you won't take the time to follow, or even read, the 

instructions they've already posted, why would they think they'll get 

what they want when they tell you?  

The point is making your manuscript look like it was created by a 

professional writer won't get you the sale. But ignoring the manuscript 

guidelines is generally the fast track to the rejection pile. But here's 

the good news. With this article, you'll use Microsoft Word to create a 

professional document, following established guidelines for 

manuscripts. Best of all, it will be there every time you need it, since 

we'll create it and save it as a template. 

I find this very helpful with the "Hesitation Shuffle" on two fronts: since 

the formatting is all finished before I start writing, I don't get 

sidetracked with technical stuff when I sit down to write. And since the 
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article was written to the requested standards, when I finish the final 

proof, I'm ready to submit it! 

Creating a Manuscript Template 

In Microsoft Word, a template is a pattern, or a fixed outline, that 

takes your choices for formats (fonts, size, color, justification, and 

margins) and applies them to a document. The general template is 

never changed by writing in it, however, because template's require 

that you rename the document before you save it. Thus, the original, 

which is the template, always remains as it started. That's a big help! 

Ready? Good! First we have to create the template, so let's start at 

the beginning. 

Step 1: Create a blank file 

We'll start by creating a new blank document.  File -> New… brings 

us the "New" window on Word 2000 and earlier, or the New 

Document Task pane on Word XP and 2003.  In either case, we want 

a blank document, so click the appropriate choice for your computer. 
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Now, we have a few things we need our manuscript template to 

achieve. First, let's determine what your manuscript should look like. 

According to Writer's Market, our manuscript should have no title 

page, but start with vital contact information about us in the upper left 

corner and article information in the upper right corner. Also 

remember to stay away from "fancy" fonts on this document, so I will 

stay with Times New Roman, at 12 points. The margins should be set 

at 1.25 inches for all sides. Ready? Let's walk through setting each of 

these on our blank page. 

Step 2: Creating the Format 

Margins: File-> Page Setup. On the Margins tab, note that the "Apply 

to: " setting reads "Whole Document," and then set the top, bottom let 

and right margins to 1.25 inches. (It might be easier to do 1.2 for top 

and bottom, using the spinner buttons beside each setting.) Once you 

have it, click the "OK" button. 

Font: First, choose Edit -> Select All. Then, using the menu Format-

>Font, choose Font: Times New Roman,  Font Style: Regular, and 
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Size: 12. Click OK. (If you use the Formatting toolbar, simply ensure 

that the bold, italic or underline buttons are not on.) 

Line Spacing: Check Format -> Paragraphs, and see that in the third 

section, Spacing, Line spacing is set to Single.  

Step 3: Applying the constants 

Time to place the Author Information! At the top left of the page, type 

your name, then tab 7 times, and type "About 0 Words" on the right 

hand side of the page. If "Words" flips to next line, delete a tab until it 

stays completely on the top line. Hit the enter key.  

(When you write an article, you'll change the zero to the final word 

count to give the editor the idea of the length of the article.) 

Next line is your address, then hit tab again 7 times, and type any 

information that the guidelines ask for, such as copyright or rights 

offered. (If you use (c) it should automatically become ©). Then type 

the year, and your name. (Note: I've never done this, but it is 

recommended by Writer's Market 2003 in their basic guidelines, so I 

leave it up to you.) Hit Enter. 

Next line: Your City, State and zip code. Hit Enter 

Next line: Phone Number. Hit Enter. 
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Next line: email address. Hit Enter. 

Now, hit enter 10 times, and then center your text. Type your Article 

Title in capital letters.  

Click Format -> Paragraph, and under the section of "spacing" note 

the line spacing and open the drop down menu. Click on "Double." 

(Check to make certain this is the proper format for your submission 

before you send.  Some places have different requirements, but this 

is the usual setting.)  Click on OK, then hit enter, and type "By" and 

your name (or pseudonym, if you are writing it under another name). 

Hit enter twice more. Click Format -> Paragraphs, and set Left indent 

for 5 spaces. Hit OK. 

All that's left is the header and page number. This is easy, but there 

is one trick to it, so watch closely. 

Step 4: Setting the Header 

On the menu bar, click View -> Header and Footer, and the header 

box should open, along with a header/footer toolbar. Click inside the 

dashed Header box, and click the right hand justify button on the 

Formatting toolbar. Then type your last name and a dash. Locate the 
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"insert page" symbol on the header/footer toolbar, and click it. (It 

looks like a piece of paper with a single pound sign "#" on it.) 

Look at your header. If your name is on the right side, followed by a 

dash and a # sign, you should be set. Click the "Close" button on the 

header/footer toolbar. 

Whew! A lot of clicking, huh? But there are only two steps left! 

Step 5: Setting the print options  

On the menu bar, click File->Page setup and choose the "Layout" 

tab. Again, making certain it says "Apply to: Whole Document," use 

your mouse to put a check mark in the box that says "Different first 

page" and click OK. 

Side step: Issuing a challenge to yourself! 

OK – we could save it now as a template, and we'd be done. But I go 

a step further, and write the first paragraph for the "dream story." It 

serves two purposes: First, I get to check that my settings are correct 

for my article, and fix them before I save it if they are not. More 

importantly, I've actually issuing myself a challenge each time I start a 

new article. You can do the same.  
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On my new template, I clicked into the spot I'll be typing text when I 

actually use the template -- in other words, at the start of the story, 

following the byline. This time, I typed the following paragraphs: 

"Start with a killer lead, one that grabs attention by providing color 

and sound. Always look for why my readers would care, and then 

follow it with a great hook or killer quote. To really make it fly, using 

action verbs, and show, don't tell, why this issue grips their heart. If 

appropriate, place a quote here from an authority, and the next 

paragraph offer a supporting point of view via second quote.  

"If the article poses a radical change, or a charge, offer a counter 

quote, and a rebuttal from another authority. But if so, return to your 

opening people, and let them explain why they are correct. Leave the 

readers with a clear choice.  

"For bonus points, tie the ending back to the lead sentence. Finish it, 

proof it, and send it off! But don't wait by the mailbox for the 

acceptance letter – it looks too uncool for a big time author. Besides, 

you should have three more articles written and placed by the time 

you hear back on this one!" 

Lazette Gifford, Editor 
vision@lazette.net 

114 of 147 



Vision: A Resource for Writers 
Issue # 20 

115
 

Sorry about the brash style, but it seems to help me when I use the 

template. As I said, it challenges me, and it reminds me this article is 

more than simply typing in some words. I have to make a point, make 

a difference, and make it count. (Of course, I also have to remember 

to highlight all those paragraphs when I start typing the new article, 

so they are deleted, or some editor somewhere will be very confused, 

and I'll be very embarrassed!)  

Step 6: Saving your template! 

OK, you've typed your test message to yourself, and we are at the 

moment of truth. Ready? Click File -> Save As. Along the bottom of 

the "Save" window that appeared, there are two entry boxes. The first 

is the "File Name:" field that we use all the time. The second is the 

"Save As:" box. In the "File Name:" box, re-title this document 

"Manuscript Template" and then click the drop down arrow in the 

"Save As" box. Find "Document Template" and click on it ONCE. At 

the top of the "Save" window, the "Save In" box should automatically 

change to "Templates." If you click "Save" now, your manuscript 

template will be available in the General Templates folder. Click 

Save. (If another info box opens, click Save or OK on it, too.)  
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Now, as you look at the template, note the name in the title bar has 

changed to what you called it when you saved it. Congratulations! 

You did it! Close the newly named template.  

Now, how do you get it back? Click File-> New, and under either the 

New box or the New Document Task Pane, look at your templates. 

(In Word 2000 or before, make certain you are in the "General" tab.) 

Click on the Manuscript Template, and it will launch. 

Notice the new document is now called "Document" (some number), 

meaning you will be forced to save it as a different name when you 

save it the first time. You've done it! 

If you'd like, here's one last test. Using this new document, and 

before you make any changes, do a File -> Save As command. This 

time, leave the File Name as is, change the "Save As" to "Template 

Document" and then go up above to the "Look in" box. Drop that 

menu open, and change it from "Templates" to "Desktop" and click 

Save. Close the document, and then check your desktop. There is 

now an icon on your desktop for your Manuscript Template! You have 

created a one button quick start to a new article! 
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While this may seem like quite a few steps, let's recognize what we 

achieved: 

You now have a professional looking manuscript.  

You have quick access to it, from your desktop.  

Every submission will now say "I'm a professional writer."  

And if you are the type to have a hard time starting, you've just 

removed a huge roadblock. With a double click of the mouse, you've 

already started your article. You might as well finish it! 

Next Issue: Using Word to work with editors and co-authors for 

changes and additions! 

Russ Gifford is a certified Microsoft Office Specialist Master, 

and a candidate Master Instructor. He has also written and sold 

over 200 articles, and recently accepted a contract from the 

University of Nebraska to write two chapters of an upcoming e-

commerce training manual. 
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Book Review: 

Painless Grammar 

Reviewed by Andi Ward 
©2004, Andi Ward 

 

If you're like me, you don't remember much (if any) of the grammar 

taught in school all those years ago. Faced recently with the daunting 

task of checking over a manuscript, I realized it was time to go back 

to the books and refresh my faulty memory. 

Don't get me wrong, most writers have an "ear" for the written word 

but, truthfully, where do you really need a comma and where is it 

optional? Or are commas ever optional? Rather than dig through the 

vastness of a style manual, I went looking for a basic grammar book 

and found Painless Grammar. I'll be honest, the title made me pick it 

up, and the freaked-out cat on the cover was cute too. However, in 

flipping through the book, I found what I was looking for. 

Admittedly, Painless Grammar is written for children (sixth to eighth 
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grades). Even as an adult I found it to be user-friendly, giving clear 

examples and explanations rather than spelling out a lot of rules and 

do's and don't's (which I couldn't remember in the first place). The 

one detraction from this is that all the examples are aimed at children 

and young adults, but hey, that's the original audience. 

Dr. Elliott gives explanations in plain, easy-to-understand English. 

This only covers the most basic of grammar rules, so if you're looking 

for something in depth, stick with Shrunk & White. Elliot cracks jokes 

as she makes points, which helps to trigger my memory. She gives 

examples galore, showing and explaining why something is wrong 

and why something is partially right or just plain right. There are 

exercises for everything covered and little tests at the end. (Answers 

included elsewhere, by the way.) At the end of each section, there 

are sentences to be edited as a self-quiz. 

Painless Grammar is just the refresher course I was looking for. If 

you're searching for an alternative to memorizing Strunk & White, I 

highly recommend this book. 

ISBN: 0-8120-9781-5 / SRP: $8.95 
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Web Review: 

The World Heritage Tour Site 

By Maria Gianakos 
©2004, Maria Gianakos 

 

http://www.world-heritage-tour.org 

Incredible! 

This site requires a fast connection and a powerful computer, but if 

you have both you can visit historical sites from around the world in a 

way that is almost breathtaking.  This is an exceptional site for 

historical writers, or writers who just want to get the feel of something 

different for their own stories, even if they are not based in history.  

There are also some breathtaking natural heritage sites included, as 

well as historical ones. 

According to the site, the object of the organization is:  

Production of virtual reality movies for all sites registered 

as World Heritage by the UNESCO (United Nations 
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Educational, Scientific and Cultural Organization).  

 

Dissemination of these virtual reality movies for 

documentation and promotion of the World Heritage.  

 

Using multimedia techniques in an edutainment mode to 

raise awareness on the preservation of the World 

Heritage.  

 

Promoting the notion of sustainable tourism in the head of 

local administration, tourists and travellers.   

What this means is that you can visit several historical sites (and they 

add more as often as possible) that are set up in such a way that 

using the mouse, you can turn around within the view and look at it 

from several angles as well as zoom out and in. 

What is the view from Hatshepsut's temple in Egypt?  You can come 

in at three different locations, one of them looking at the long, 
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impressive wall of columns and square openings -- but turn around.  

You can see what lies behind you. 

Or perhaps you'd like to see a couple rooms from the tomb of 

Rameses IV in the Valley of the Kings.  The paintings on the wall are 

lovely... but don't forget to look up... 

Would you rather visit the Great Wall of China and look out over the 

land, or study the tombs of the Ming Dynasty? 

This is a site worth visiting again and again, especially as new sites 

are added.  While most of the work so far is in the Near and Far East, 

they have started to include a few more pieces from the west and will 

continue to include more.  

Stop by and check it out.  There is inspiration in every sight, and for 

those of us who have very little hope of ever really going to these 

places, it's a joy to find a place that is almost like being there. 

One of my favorite locations at the site is here: 

http://www.world-heritage-tour.org/asia/my/kinabalu/km7.html 
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This is one of their natural views rather than historical.  Turn to the 

right... 

Have a lovely visit, wherever you choose to go. 

http://www.world-heritage-tour.org 
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Mar's Market Report # 2 

By Margaret McGaffey Fisk 
©2004, Magaret McGaffey Fisk 

 

In 2003, Vision published an article of mine about submitting fiction 

manuscripts. Included in the article, I suggested culling publication 

announcements for possible markets, especially those friendly to 

previously unpublished writers. 

When the Forward Motion December 2003 Market challenge began, I 

realized I needed to take my own advice.  The markets presented in 

this column were found in various "woo hoo" lists.  Though many of 

the markets also appear on reputable sites, such as www.ralan.com, 

by finding them in the publication announcement reports, I have 

concrete knowledge they are open to new and/or unpublished 

authors. 

While many of these markets don't offer "pro" rates, they all provide 

some compensation.  In my opinion, offering payment is an indication 

of the editor/publisher's commitment and so markets with some 

compensation are more likely to stay around.   
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Genre  Hard Science Fiction/Science Articles 

Title  Artemis Magazine 

Editor  Ian Randal Strock, Editor 

Address 

 1380 East 17 Street 

 Suite 201 

 Brooklyn, NY 11230-6011 USA 

Sub Email  None 

Specifics 

     Looking for near-term, near-Earth, hard science fiction 

and non-fiction science articles focused on space travel 

and lunar development. 

Requirement 
     Short stories up to 15,000 words but shorter is better. 

Articles up to 5000 words. 

Payment  3-5 cents per word 

URL for site  http://www.lrcpubs.com/artemismagazine.html   

URL for 

guidelines 
 http://www.lrcpubs.com/artemismagazine/guidelines.html
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Genre  Fantasy and SF 

Title  Fantastic Stories of the Imagination 

Editor  Ed McFadden 

Address 
 PO Box 329 

 Brightwaters NY 11718-0329 

Sub Email  None 

Specifics 

     Overbooked and closed to new submissions 

until 2005. Looking for well written, entertaining 

stories with SF/F elements, though genre mixing 

acceptable. 

Requirement      2000-15,000 with average of 4000-5000. 

Payment  1-5 cents per word 

URL for site  http://www.dnapublications.com/fantastic/index.htm

URL for 

guidelines 
 http://www.dnapublications.com/info/guide.htm#pw
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Genre  SF/Fantasy/Horror 

Title  FutureShocks 

Editor  Rob Young 

Address  Email submits only 

Sub Email 

 Futureshocks@publicist.com 

(subject must contain 

"submission")  

Specifics 

     Looking for character-driven, 

strongly plotted stories and some 

non-fiction articles on select 

subjects. 

Requirement  1000-10,000 words. 

Payment 

     1-3 cents a word up to 5000 

and 1/2 cents for any more up to 

10,000. 

URL for site  http://www.futureshocks.com/  

URL for 

guidelines 
 http://www.futureshocks.com/ 
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 Genre  SF/Dark Fantasy/Horror 

Title  Far Sector SFFH 

Editor  John T. Cullen, publisher 

Address  None 

Sub Email  submissions@farsector.com 

Specifics 

     Looking for SF, dark fantasy and horror with 

strong story telling. Willing to extend to other 

genres for good stories  

  

Requirement      Open to any length but prefers 4000-6000. 

Payment      $10 advance + royalties from fictionwise sales. 

URL for site  http://www.farsector.com/index_main.htm  

URL for 

guidelines 
 http://www.farsector.com/about.htm#submissions1
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Genre  Dark Fiction (Fantasy/Horror) 

Title  Blood Rose 

Editor  Mark W. Worthen, Editor 

Address 

 Blood Rose Ezine 

 P. O. Box 105501 

 Jefferson City, MO 65110 

Sub Email  bloodrosemag@hotmail.com (preferred)  

Specifics 

     Looking for dark fiction with a supernatural 

element, horror and dark fantasy mainly but 

will take some dark SF. 

Requirement      1500 to 8000 words. Query if longer. 

Payment 
     $20 per story (one lead story 3 cents per 

word up to 3000). 

URL for site  http://www.bloodrosemag.com/index.html  

URL for 

guidelines 
 http://www.bloodrosemag.com/guidelines.html
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Good News from Forward Motion 

Latest publishing news from our members. 

 

Holly's latest book is in the 

bookstores!  If you can't find it order it 

from your local book stores!  (This is 

better for authors than ordering on-

line -- it keeps their numbers up 

where they count!)  

Holly Lisle's Talyn and Romantic Fantasy #2 have sold to Tor!  

 

Forward Motion Moderator Margaret McGaffey Fisk sold her first 

short story!  "Curve of Her Claw," has been accepted by Fantasist 

Enterprises for the Cloaked in Shadow: Dark Tales of Elves 

anthology, due to be published in late 2004. 

 

Justin Stanchfield newest story, "Sisterhood of the Stone" is available 

at  Fictionwise.com.  He has also placed a story with Cicada 

Magazine. 
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Be sure to check out hardbound book The Burning Land by Victoria 

Strauss! 

 

Tamara Siler Jones's book Ghosts in the Snow is now also 

represented by APA (Agency for Performing Arts) which will handle 

the film/TV sale. 

 

Lazette Gifford's latest releases: 

 

(Order here) 

A talented writer with 
a gift for 
worldbuilding...  

CJ Cherryh 

Blood, bullets, 
knives, explosives 
and a 
genderbender 
twist---with a 
healthy dose of 
heart. Works for 
me.  
Jane Fancher  

Lazette Gifford 
writes edgy, 
make-you-think 
tales -- tough 
people in hard, 
strange places 
facing big 
trouble. And 
these two 
stories are 
some of her 
best -- excellent 
through and 
through --  
Holly Lisle 
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In 2039 Los Angeles, half ruined by 

devastating quakes, is in the hands of three 

policing forces -- the National Feds, the State 

Militia and the city's own Local force, all of 

them squabbling over jurisdiction.  Religious 

intolerance grows under the watchful eye of 

the CCP, and survival is a precarious game of 

chance and cunning. 

And in this maelstrom of disaster, two Local detectives working on 

their first case together, try to find a drug dealer with a secret he's 

willing to sell -- if he lives long enough. 

Unfortunately, Elias Singer is about to learn that his new partner has 

a dangerous secret all his own... 

Singer and St. Jude:  

The Lost Cause 
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Eons ago powerful mages cursed all magical beings to walk the land 

only in the dead of the night. The people of 

Dodano hide behind their shuttered windows 

and locked doors, never looking upon the 

creatures in the moon light. Gradually growing 

to despise all magic, they have even turned 

against the mages and outlawed their powerful 

art. 

However, now an evil that will not be stopped by mere locked doors is 

stalking the humans.  

A shame that in their righteous zeal the people murdered the last true 

mage, leaving only Dacey, the apprentice, to stand between them 

and destruction -- that is if they don't capture and kill him as well. 

Dacey's Dream 
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Submission and  

Guidelines 

 

One of the fun aspects of working on Vision is helping a new writer 

find an article subject, and then helping them through the steps of 

refining the idea and writing and editing it.  However, as I pointed out 

previously, I have less time to do that if I have to rework too many 

articles just to fit the guidelines.  

Vision generally runs, in the PDF version, between 160 and 200 

pages. That's a lot of material to edit, format, and make into three 

distinct versions (html, PDF and Palm) every two months.  

So, here are the things I want the rest of you to consider when you're 

writing an article for Vision:  

Read the guidelines and follow them.  If you have a question about 

the guidelines, email me at Vision@lazette.net and ask. 
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Don't write an article and send it off without proofing.  In fact, read it 

more than once.  Let it sit for a day or two, even if you are running 

late.  I would rather have a well edited late article than a messy one 

sent on time. 

Don't worry about the theme of the upcoming issue and think that 

your article won't fit in.  I want anything that has to do with writing, 

from how you think up a story to finding a proper pen. 

If you love writing and have anything at all that you can offer to other 

writers, consider writing 500-2000 words for one of the upcoming 

issues.   

Have favorite writing-related books or web sites that you think could 

help fellow authors?  Consider writing a short review of them.  I am 

especially in need of web site reviews! 

Did I mention reading the guidelines? 

Writing for Vision is a lot easier than most people assume, and a few 

of our writers have gone on to sell material they first published in 
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Vision, or to use the 'sale' as part of a resume to get a job at some 

other publication.  

So, let's work together and get the next issues done.  

Oh, and do go read the guidelines...  

I am interested in all facets of writing, from first-person experience 

articles to genre-specific how-to’s and informational articles about 

your area of specialization – whether that be history or science or 

nursing or long-distance running – and how and where your specialty 

can be used correctly by writers. Write something that will help other 

writers, and I'll be interested in taking a look. 

Starting in 2004 Vision will pay half a cent per word for articles.  

That's not much money, and I'm going to be asking a lot for that half 

cent -- both ezine rights as well as the right to publish anything we 

choose in a POD 'Best of' Anthology at the end of the year.  By 

printing the anthology, we hope to make back the funds that I will be 

putting into Vision to buy the articles and perhaps even make enough 

to fund the following year's article acquisitions. 

Lazette Gifford, Editor 
vision@lazette.net 

136 of 147 



Vision: A Resource for Writers 
Issue # 20 

137
 

I will be limiting the number of articles bought, and 2000 words ($10) 

will be the cut off point for payment.  All the other guidelines remain 

the same.  I will be looking for articles on theme-related, general 

writing and genre topics.  If you have some suggestion that you think 

might help another writer, consider writing it into an article and 

submitting it to Vision. 

We strive to maintain professional standards.  Manuscripts must be 

professionally formatted, as free from spelling and grammatical errors 

as you can make them, and in what you perceive to be final draft 

form. We will not welcome massive rewrites of a piece after we have 

accepted it – when we accept it, we consider it pretty close to 

finished, and will only edit it to our standards. If we feel that it need 

massive rewrites, we won’t accept it. 

If you have any questions, or wish to query about an article, email  

Vision@lazette.net  
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Guidelines: 

Articles must be at least 500 words with 2000 words as the 'soft' 

top.  I'm willing to go over that count if the article needs it, but 

payment stops at 2000 words.  

Check your spelling and grammar!  Also, if you are from a 

country that does not use US spelling conventions, let me know in 

the email.  That will stop me from making several 'corrections' 

before I realize they aren't mistakes.    

PLACE YOUR TITLE AND YOUR NAME AT THE TOP OF THE 

DOCUMENT.  I hate having to go search through emails, checking 

attachments, to figure whose article I'm actually reading.   

Title 

By 

Your Name 

Use one of these fonts: Courier, Courier New, Times New Roman, 

Verdana or Arial, 12pt.  
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Double space your manuscript.  

Do not indent . 

I would like submissions to be made in either Word Doc files, or .rtf 

files, and as attachments to the email. (I believe that WordPerfect 

allows .rtf saves, doesn't it?)  If you use Works, a regular file will 

do, although (at least in the 4.5 version I have), this program also 

allows for an .rtf file save.   

A plain text copy (.txt) can be sent, but be certain to mark any 

italics like this: *before and after the section in italics*, and bold 

likes this: _before and after anything in bold._  If you cannot do 

attachments, use the body of the letter as the last resort.   

Indicate book titles with italics.  And yes, that means if you are 

doing a Word doc or rtf that you can use actual italics and not an 

underline to indicate italics. (This is not common submission 

procedure, but it's far easier for me since I can cut and paste to my 

wysiwyg web page editor.)   
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Do not use an underline for emphasis.  Underline on websites 

indicates a link, and people often send emails to say the link is not 

working.  Use italics or bold.   

NO HTML code except for links, and those written in this fashion:  

http://www.whatever.com/this.htm  

Provide the ISBN #s and publishers for all books mentioned or 

reviewed.  Do this by adding the title, author, publisher  and ISBN# 

at the bottom of the file.  The same is true for articles -- be certain 

to cite them.   

An additional note to Word users: You should turn off the 'smart 

quotes' option in Word which can be found under Tools-

AutoCorrect and then the tabs AutoFormat while you type AND 

Autoformat.  Also uncheck the symbol replacement for --.  While 

Smart Quotes look really neat on the screen, they sometimes 

translate to funny little squares that cannot be taken out with the 

'find-replace' feature, but have to be hunted down by hand.  If you 

are submitting anything electronically, you will very likely hear back 

Lazette Gifford, Editor 
vision@lazette.net 

140 of 147 



Vision: A Resource for Writers 
Issue # 20 

141
 

from the editor on these.  And remember -- a lot of print publishers 

are now asking for electronic copy for their end as well. 

We've been receiving very good articles, and I hope that all of you 

look at the list of upcoming issues at the bottom of this page  and 

choose something you feel comfortable with writing about.  

We are also still looking for general genre-related articles.  If you 

would like to write an article on how to research romantic settings, 

the proper use of codes in spy thrillers, etc., let us know.  The 

genres we like to cover in each issue are:   

  Fantasy  
  Historical Fiction 

  Horror  
  Poetry  
  Romance   
  Science Fiction  
  Suspense & Mystery  
  Young Adult & Children  
  Young Writer's Scene 

And we are always interested in articles about the act and art of 

writing. 

Lazette Gifford, Editor 
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Upcoming Themes for Vision in 2004: 

   

• May/June -- Writing Shorter Fiction  (April 10 deadline) 
   

• July/August -- The Fine Points of Critiquing (June 10 deadline) 
   

• September/October -- Essentials of Marketing  (August 10 
deadline) 
   

• November/December -- Toys for Writers (October 10 deadline)  

Bear in mind that since we are now a paying market, the earlier 

material is likely to get a spot in the issue, while things coming in 

closer to the deadline will not unless there is still space -- and 

funds -- left for them.   

Thank you!  

Lazette Gifford 

Managing Editor 

Questions?  Queries?  Submissions?  Email me! 

Lazette Gifford, Editor 
vision@lazette.net 
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How to Join Forward Motion 

 

The Forward Motion community came into existence for several 

reasons. First, I hadn't been able to be a part of a writers' group or 

attend conventions in a few years, and knew that situation wouldn't 

be changing in the foreseeable future, and I missed the company of 

readers. Second, I am fortunate to be able to do the thing I enjoy 

most for a living, and I wanted to be able to help others who shared 

my obsession find their way to living their dreams. Third, I knew a lot 

of people -- writers and readers - - who I thought should meet each 

other. 

When the Internet suddenly erupted with free, easy-to-use 

community-building tools, I suddenly had the solution to bringing 

those many people together and sharing what I knew with them and 

letting them share what they knew with me and each other.  

The community has three sections -- public boards, which anyone 

can read and in most cases anyone can post to; private boards, 

where writers can post sections of works-in-progress and receive 

critiques of them; and restricted boards, which include the Young 

Writers' Scene, and boards for various classes. The private areas 

require community membership and are password-protected to 

preserve all publication rights for each author's use. The restricted 
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boards further require submission of an application -- in the case of 

Young Writers' Scene, to make sure the applicant is under seventeen 

years of age; and in the case of Erotica & Sensual Fiction, to make 

sure the applicant is eighteen years of age or older and that it is legal 

for him or her to participate in a board containing erotic content. All 

restricted class boards will have application procedures posted as 

new classes open.  

To participate in the public boards , all you have to do is read them 

and post to them. If you register with the community, you gain the 

ability to post in HTML and use signatures, add your picture or avatar 

to your posts, use our private messaging and e-mail systems, rate 

other posts and other users, edit your posts, and so on. But in most 

cases there's no requirement to do either. (The Rants board, due to a 

short-lived problem with trolls, requires membership to post.)  

To participate in the private portion of the community, where you can 

receive crits on your own work and crit the works of other writers and 

participate in various writing exercises, dares, and challenges, you 

must join the community. You will have to be logged in to gain access 

to the private boards.  

Anyone may join the community. Simple click this link: 

http://fmwriters.com/community/dc/dcboard.php?az=register and fill 

out an application. Membership is free and approval is automatic. The 

excellent site moderators can help you find your way to topics of 

interest to you, crit circles that can help you, and ongoing projects, 
Lazette Gifford, Editor 
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challenges, exercises, workshops, articles, and contests that might 

inspire you.  

We have a good group of people in the Forward Motion community. 

Come look us over, introduce yourself, take part in a few 

conversations -- or jump straight into the deep water and start 

working on your book or short story.  

We're here to help you make long-cherished dreams turn into reality. 

I hope you'll join us.  

Holly Lisle 

Lazette Gifford, Editor 
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Masthead 

 

Vision is published bi-monthly and pays .005 (one half) cent per 

word. I will be happy to look at any articles that will help writers.  

We pay one half cent per word for material. 

Guidelines for Vision 

If you have any questions, or would like to propose an article for an 

upcoming issue, feel free to drop a line to either of the editors 

below.  We look forward to hearing from you! 

Lazette Gifford, Publisher and Editor 

Vision@lazette.net  

Copy Editor: 

 Ellen Wright  
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Entire contents Copyright 2004, Forward Motion E-press. 

All rights reserved. Reproduction in whole or in part without 

permission is expressly prohibited, except that the entire 

issue may be freely distributed, so long as it remains 

complete and unchanged. 
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